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�Purpose of This Guide

Spreadsheets are among the most frequently used applications for business purposes. Most offer a wide range of functions and they can contribute substantially to a company's overall performance and productivity. Because of their importance, the job of selecting a spreadsheet application should be conducted carefully and thoroughly.

Although there are several good spreadsheets available, not every one is a good match for a given set of business needs, and some offer more capabilities than others. In this document, the features of two popular spreadsheet programs, Microsoft�SYMBOL 226 \f "Symbol"� Excel version 5.0 for Windows�SYMBOL 228 \f "Symbol"� and Lotus�SYMBOL 226 \f "Symbol"� 1�2�3�SYMBOL 226 \f "Symbol"� release 4.0 for Windows, are compared.

The first section of this document looks at a few of the broader issues that should be considered when selecting a spreadsheet. A set of criteria has been developed based on the way spreadsheets are used in the workplace. It specifically looks at product features and support services. This criteria is applicable to all spreadsheets and should be used in your product evaluations.

Following the list of criteria is an evaluation comparing Microsoft Excel with Lotus 1�2�3, based on these areas of functionality. The purpose is to measure the capabilities and usability of the two products so that evaluators can make informed decisions as to which is better for their needs.

Although this evaluation was prepared by Microsoft, it is meant to be performed by independent evaluators that have installed both Microsoft Excel version 5.0 and Lotus 1�2�3 release 4.0 for Windows on a personal computer. As you go through the steps of the evaluation, we encourage you to investigate each of the specific feature areas in further detail. 

Take special note of the “Differences” section that accompanies each feature area. This section states the key differences between the two products. Also provided are samples of Microsoft Excel features. Often these are short computer exercises to demonstrate the capabilities. Other times, these are images of the screen to illustrate the feature. We encourage you to experiment with both Microsoft Excel and Lotus 1�2�3 to see the differences for yourself.

Note: Some of the exercises use sample files that must be installed during  setup. When you run the Setup program for Microsoft Excel 5.0 be sure to choose the Complete/Custom button when you are asked to choose the type of installation. The files used for these exercises are installed with the Data Access component. The Complete/Custom screen contains a list of options. The Data Access option must be selected. 

If you do not want to install all of the data access files, click Data Access and choose the Change Option button. In the Data Access screen, you can cancel any of the drivers in the Options list by clicking the option button. Make sure, though, that the following options are selected:

�SYMBOL 183 \f "Symbol" \s 10.5 \h�	Microsoft Query

�SYMBOL 183 \f "Symbol" \s 10.5 \h�	Help for Microsoft Query

�SYMBOL 183 \f "Symbol" \s 10.5 \h�	Microsoft Query Cue Cards

�SYMBOL 183 \f "Symbol" \s 10.5 \h�	dBase™ Driver

When you have made your modifications, choose the OK button to return to the Complete/Custom screen. Choose the Continue button on the Complete/Custom screen to continue the setup.

The Importance of the Company

Feature comparisons are usually the baseline used when evaluating spreadsheets; however, evaluators should consider the company as well as the product.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Reputation and Innovation

	Microsoft has a strong reputation as a leader in the computer industry. Much of our success is due to the importance we place on our customers as well as technology. Our products are typically the first to offer the most advanced features. Furthermore, our experience with the Windows operating environment allows us to optimize our applications to take advantage of its power and ease of use. Because of our innovation and strong market position, our products have become standards in this industry.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Strategic Direction

	Microsoft has invested considerable effort in defining a long-term strategic direction for our system and application products, Information At Your Fingertips. To achieve this, Microsoft develops product technology with a focus on increased intelligence, ease of use, and customer satisfaction. Microsoft understands the demands you face in your work, and produces tools to make information timely, manageable, and accessible.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Product Family

	Microsoft Office offers a full line of integrated desktop applications to address all of your business needs. Product developers have worked diligently to ensure menus and interfaces for the Office applications are consistent,  reducing the learning curve for our customers. Additionally, Microsoft developed the OfficeLinks technology, based on the Object Linking and Embedding (OLE) 2.0 standard, making it possible to easily share text, data and graphics between applications. Our focus on interoperability means that the products are designed to work closely together for greater productivity.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Maturity

	Microsoft has been in the software business for over ten years. We have broad experience in almost every segment of the software market and have invested heavily in understanding how people use technology. We know how to respond to the many issues facing the software industry today while designing applications to help our customers be more productive. Due to Microsoft's longevity and industry standing, an extensive support network has developed including internal services as well as private solution providers, trainers, and developers of additional products.

�Advantages of the Windows Operating Environment

If you are currently using an MS�DOS�SYMBOL 226 \f "Symbol"�–based spreadsheet, you may not be familiar with the advantages of the Windows operating environment. Windows-based products offer the following:

�SYMBOL 183 \f "Symbol" \s 10 \h�	Consistent Functionality of Common Tasks

	The Windows interface was designed to make common tasks easier and more intuitive. Most Windows-based applications are consistent in how they offer functionality to users through the Windows interface. Users of all levels benefit because they can apply their Windows-based skills to each application.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Standard Technologies for Exchanging Data

	The exchange of data among different applications is an important ability that the Windows environment offers. For example, you can copy data from a Windows-based spreadsheet or graphics program and paste it directly into a Windows-based word processing program. Windows offers several different ways of exchanging data between applications, including dynamic data exchange (DDE) and OLE which have been adopted as industry standards.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Visual Presentation

	A good spreadsheet that utilizes the Windows environment has many visual benefits: multiple windows for worksheet files and graphs; drop-down menus; dialog boxes; and WYSIWYG (what-you-see-is-what-you-get) display and printing of fonts, colors, borders, and graphs. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Advanced Operating System Features

	The Windows environment offers many advanced features such as the ability to switch among applications, multitasking, and virtual memory. These features make users much more productive by taking greater advantage of the underlying microprocessor.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Transferable Spreadsheet Skills

	A good Windows-based spreadsheet makes it easy for you to transfer the investment you have made in learning your MS�DOS–based spreadsheet to the new environment. For example, Microsoft Excel allows you to continue using Lotus 1�2�3 commands while demonstrating the equivalent Microsoft Excel and Windows approaches to the same task. Plus, Microsoft Excel reads and runs many Lotus 1�2�3 macros without modification. Because of the capabilities offered through Windows, you can be immediately productive while learning at your own pace.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Overall Ease of Use

	Because of the capabilities discussed above and the overall design of the Windows environment, Windows-based applications are very intuitive and easy to use. Many tasks accomplished by multiple keystrokes in MS�DOS–based spreadsheets require only the simple click of a button or drag of a mouse in Widows-based applications. The design of the interface and the ability to directly manipulate data and objects creates a product that is considerably easier to use.

�Spreadsheet Criteria for the Windows Environment

Product Capabilities and Features

Microsoft Excel was introduced for the Apple® Macintosh�SYMBOL 226 \f "Symbol"� in 1985 and for the Windows graphical environment in 1987. Over the years, Microsoft Excel has consistently taken the lead in defining how a graphical spreadsheet should work, and how spreadsheet functionality and usability should be optimized for a graphical environment. Based on extensive customer research, press input, and more than eight years of experience, we offer the following list of spreadsheet criteria to provide a framework for your evaluation that looks beyond traditional feature-by-feature evaluations.

Basic Usage

Basic usage refers to common tasks involved in creating and editing worksheets. This category includes working with files, building worksheets, and managing simple lists of information. These are tasks that people do often and should be as streamlined as possible. Your spreadsheet should:

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Improve your proficiency by being intuitive, accessible, and intelligent.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Introduce you to shortcuts and more powerful features.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Streamline your work by automating routine tasks.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Help you manage rows and columns of information.

Data Access and Analysis

Accessing data from various database products is critical to many organizations. In addition, spreadsheets must offer comprehensive analytical features to help make sense of all this data. It is important for a spreadsheet to:

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Import text in a usable form. 

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Access external databases seamlessly.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Facilitate analysis by structuring data for you.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Provide an extensive library of functions and various what-if analysis features.

Working with Multiple Applications

Windows products employing a consistent interface and design allow you to leverage your learning and training investment among many products. Additionally, applications that support the standard OLE technology can share data between applications, allowing you to easily create compound documents. Key features of a spreadsheet claiming consistency and integration are:

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Maintain Windows standards and cross-application consistency.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Support full capabilities of the OLE 2.0 standard in an easy and intuitive manner.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Comply with the OLE 2.0 standard to simplify editing of embedded items.

Customization and Programming

Customization ranges from tailoring your worksheet to building custom solutions. Your spreadsheet should address the realm of programming abilities and offer features for the beginner as well as the advanced user. Different levels of programmability allow new users to automate routine tasks and enable developers to create specialized systems, such as an Enterprise Information System (EIS). Your spreadsheet choice should:

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Include basic tools to add custom commands and functions easily.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Offer a programming or macro language to combine features of multiple desktop applications into custom solutions.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Protect your programming investment in future versions.

Charting and Presentation

When considering the charting capabilities of a product, you must examine both the analysis and presentation features available. Analysis is particularly important because most customers develop charts from their data to better understand the information. When comparing charting and presentation features, ensure the spreadsheets:

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Provide a wide range of charting types and capabilities to represent and analyze data.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Offer the user an intuitive interface, allowing objects to be easily manipulated in a WYSIWYG (what-you-see-is-what-you-get) environment.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Link and embed charts in other applications in the Windows environment.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Include a variety of formatting and graphic features.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Format and manipulate graphic and text objects directly and intuitively.

Workgroup

Workgroup activities are common in many organizations. Through technology, many of the activities that were done manually can now be accomplished electronically. By automating the work routing process, you can receive comments and input from other group members easily. Your spreadsheet choice should: 

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Organize comments and input from multiple people in one worksheet.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Allow multiple users to work on documents together by electronically routing and simplifying network interaction.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Provide tools to help you understand the structure of worksheets created or edited by others. 

Organization Issues

Training

Many spreadsheet users are transitioning to the Windows environment from the MS�DOS operating system. To take full advantage of the Windows environment, you need to learn its user interface regardless of the spreadsheet you choose. To help transition users to the Windows environment, your spreadsheet should:

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Support your move by providing an intuitive interface, consistencies with the Windows environment, and comprehensive teaching tools.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Provide a Help system that is comprehensive and easy to navigate.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Supply an online tutorial that helps users get started quickly.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Protect the user's work while assisting in common functions such as loading and saving.

Installation

Installation procedures should be flexible so your spreadsheet can be tailored to your business environment. In addition, they must be simple so installation can be completed quickly. When considering spreadsheets, ensure that they:

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Provide custom installation and setup options.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Guide you through network installation easily.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Offer an uninstall capability allowing you to easily remove portions of the program.

Compatibility

If you are moving from one spreadsheet (Windows- or MS�DOS-based) to another, check to be sure the spreadsheet will:

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Import files and macros from your current spreadsheet.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Support keystrokes from your application.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Offer compatibility and a consistent interface between IBM-compatible and Apple Macintosh computers, enabling you to share work across platforms.

System Requirements

Comparing spreadsheets also involves understanding the system resources they require. Your spreadsheet option should:

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Consume a minimum of system resources so that other applications can run simultaneously and with satisfactory performance.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Provide flexible control over which capabilities to install so that hard-disk usage can be minimized.

Support Services

The manufacturer of your spreadsheet should offer the appropriate support services, including a help desk and training. Support is an important criterion to consider when evaluating a software option. Check to see that your spreadsheet manufacturer will:

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Offer a wide range of support options that meet your needs.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Provide direct support over the phone from an expert.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Make training materials and courses available for your staff.

�SYMBOL 113 \f "Wingdings" \s 10 \h�	Support a network of independent consulting services for macro development and translation, database development, and custom interface design.

�Evaluation of Spreadsheet Capabilities

Overview

This following sample evaluation is based on the spreadsheet criteria defined in the previous pages. Each major criteria section (such as “Basic Usage”) is divided into various sub-sections that discuss the features both Microsoft Excel and Lotus 1�2�3 offer. Following this summary is a “Differences” section that highlights the differences between the products. Finally, Microsoft Excel sample exercises or sample screens are given to illustrate the features discussed. We encourage you to try similar procedures using the other spreadsheets that you are evaluating.

Basic Usage

Usability affects all levels of users, from beginner to developer. To improve your group's productivity, basic tasks should be intuitive and automated where possible.

Accessing Menus and Commands

Microsoft Excel

Microsoft Excel offers a hierarchy of menus based on our studies of customer usage. We have shortened the main menus by offering sub-menus that cascade for certain options. These cascading menus offer additional functions. Shortcut menus are also available by clicking the right mouse button when you are in a particular area of the window. This displays a menu that contains the most appropriate commands and options for that area.

Microsoft Excel has further simplified and reduced menu options by implementing tab dialog boxes. Similar features and options are grouped in one dialog box, clearly separated by tabs resembling file folders. The user can now easily access all the features and commands needed for one activity, such as formatting or printing without returning to the menu bar.

Lotus 1�2�3 for Windows

Lotus 1�2�3 offers a hierarchical menu structure with cascading sub-menus. Additionally, QuickMenus are available by selecting a specific field, and clicking the right mouse button. Dialog boxes are available for singular functions.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	In Microsoft Excel, shortcut menus are available in most areas by simply pointing the mouse and clicking. For example, you can bring up a shortcut menu by right-clicking the toolbar, title bar, worksheet and window areas. Lotus 1�2�3 does not offer shortcut menus in as many areas of the screen; they are only available in the worksheet, not in the toolbar, title bar, window area, or status bar.

�SYMBOL 183 \f "Symbol" \s 10 \h�	The tab dialog boxes in Microsoft Excel allow the user to set many options pertaining to an activity (i.e. printing) in one dialog box. Lotus 1�2�3 has different menu items for each option, requiring the user to open and close multiple dialog boxes.

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 9 \h�	Using your mouse, choose Tools from the Microsoft Excel menu bar, found below the title bar.

�SYMBOL 183 \f "Symbol" \s 9 \h�	Choose Auditing from the Tools menu to see a cascading menu showing you more options.

�SYMBOL 183 \f "Symbol" \s 9 \h�	From the Tools menu, choose Options to see a tab dialog box. Move through the folders by clicking various tabs. Choose the Cancel button when you are finished.

�SYMBOL 183 \f "Symbol" \s 9 \h�	From anywhere in the spreadsheet, click the right mouse button. You will see a shortcut menu giving you options available for that selection.

Using the Toolbar

Microsoft Excel

The toolbars in Microsoft Excel are very flexible. For instance, you are able to display multiple toolbars on the screen. Also, you can move these toolbars to any position on the screen by simply clicking and dragging with the mouse. Microsoft Excel offers nine pre-defined toolbars.  These can be added by clicking the right mouse button when you are on the toolbar, which activates a shortcut menu from which you select alternate toolbars.

ToolTips clearly describe the action of each button on the toolbar. Simply place the cursor on top of a toolbar button and if the cursor is stationary for a brief period a yellow ToolTip box appears immediately below, describing the purpose of the button. 

TipWizard further helps you to discover the features of Microsoft Excel. The TipWizard observes your actions, infers intent and offers personalized productivity tips. Based on what you're doing, TipWizard will tell you about shortcut keys, point out toolbar buttons, or offer a new way to complete your task. You will know that a tip is available by the light bulb button on the toolbar. When the light bulb turns yellow, click the button and TipWizard will teach you more about the product. This feature will enhance the productivity of all skill levels because it is sensitive to the features you are using.

The Name Box, which also appears on the toolbar, allows users to quickly give names to cell ranges and easily navigate to a reference. You can either choose a name from the name box, which will take you to that range, or create a new name. Tear-off palettes provide the user access to font and background colors from the toolbar. By clicking on the Color and Font Color buttons, you can see palettes with all of the available colors. These can be moved from the toolbar to anyplace on your screen.

Lotus 1�2�3 for Windows

Lotus 1�2�3 offers eight specialized pre-defined toolbars. By clicking the toolbar icon on the status bar at the bottom of the screen, you can change the toolbar on your worksheet. Lotus 1�2�3 will also define icons on the toolbar. Point to the icon and hold down the right mouse button–a description will appear in the Lotus 1�2�3 title bar. 

Lotus 1�2�3 has a naming feature that is accessible by choosing Name from the Range menu. Once you have defined a name, you may select it from the Navigator box. You can change the text and background colors by choosing Lines & Color from the Style menu.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	With Microsoft Excel, you can position multiple toolbars on the screen. In Lotus 1�2�3, you can use only one toolbar at a time.

�SYMBOL 183 \f "Symbol" \s 10 \h�	In Microsoft Excel you can drag your toolbars to any position on the screen. Lotus 1�2�3 does not allow you to reposition the toolbars by direct manipulation. You must set an option in a dialog box declaring the position on the worksheet.

�SYMBOL 183 \f "Symbol" \s 10 \h�	ToolTips, in Microsoft Excel, appear by simply holding the cursor over the button;  the user must right-click to see the definition of a Lotus 1�2�3 button. Also, ToolTips appear immediately below the button which allows the user to focus in one place. In Lotus 1�2�3, the user must look up to see the definition.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Through many visits with customers, Microsoft Excel has found that people would like an easy way to learn the capabilities and shortcuts available. Microsoft Excel is unique in offering a TipWizard, which acts as a mentor when using Microsoft Excel. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Naming ranges improves your spreadsheet design and facilitates moving around on a worksheet. In Microsoft Excel, you are able to name ranges from the toolbar, making this feature very accessible. In Lotus 1�2�3, the naming feature is buried in a menu, which discourages use.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Using colors for fonts and backgrounds can enhance the presentation of information and help focus attention to key areas of your worksheet. Using colors in Microsoft Excel is easy because the palettes are on the toolbar. The user must spend more time setting colors in Lotus 1�2�3 because this option is in the third level of a menu item.

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	Hold the cursor briefly over the toolbar. Notice the yellow ToolTip box appear below the button. From the Edit menu, choose Copy. Now click the TipWizard button (the yellow light bulb in the top right corner). The TipWizard will give you a tip relating to the copy command. Click the TipWizard button again (the light bulb is now white) and the tip box will close.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Click any cell to make it active. Go to the Name Box directly above the first column on your spreadsheet; the column and row number of the active cell will be displayed. Click inside the Name Box and type: home. Press enter. Make a different cell active. Select the down arrow on the right side of the Name Box and select “Home”. The cursor will move to the “Home” cell.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Make any cell active. Go to the lower toolbar– the Formatting toolbar– and click the down arrow on the second button from the right (the ToolTip will say “Color”). A palette will appear. Click and hold the mouse button while you are on the palette. By dragging the mouse, you can tear off the palette and move it to any location on your worksheet. When you release the mouse button, your palette will be available to you anywhere on the worksheet. You can change the cell color of the active cell by selecting a color in the palette.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Close the color palette by double-clicking in the top-left corner of the box. From the File menu, choose Close. Choose the No button when asked if you would like to save.

Working With Cells

Microsoft Excel

Microsoft introduced drag-and-drop technology using the mouse. You can copy or move a range of cells by clicking and holding the mouse button while moving the mouse. Drag-and-drop has been improved by providing shortcut menus. Simply drag while pressing the right mouse button, and a context sensitive menu will appear with relevant options.

Entering data is easy with Rich Cell Editing, which allows you to type directly into the worksheet by simply double-clicking the cell. In addition, Rich text is available in Microsoft Excel. Rich text enables users to format selected text in a cell, add superscript and subscript attributes to single characters, and mix fonts. 

To format cells, you need to go only to one tab dialog box. The Format Cells dialog box has options for number format, alignment, fonts, borders, etc. in separate tabbed folders.

Lotus 1�2�3

Drag-and-drop is available in Lotus 1�2�3, in a very similar fashion to Microsoft Excel. In addition, you can edit directly on the worksheet by double-clicking a cell. Lotus 1�2�3 offers multiple fonts and attributes in a worksheet.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	In Microsoft Excel, a warning is displayed if the user is performing a drop that will overwrite existing data. Lotus 1�2�3 does not display any warning if you are overwriting information.

�SYMBOL 183 \f "Symbol" \s 10 \h�	By studying the keystrokes of customers, Microsoft Excel has found that copying cells is a more frequent command than moving cells. Drag-and-drop using the right mouse button provides a shortcut menu with easy access to the copying functions. Although Lotus 1�2�3 offers drag-and-drop, it does not offer a special menu for copying.

�SYMBOL 183 \f "Symbol" \s 10 \h�	The Microsoft Excel Wish Line, which takes customers suggestions for improvements, received many requests for multiple fonts and attributes in one cell. Microsoft Excel 5.0 allows you to combine multiple fonts and attributes in a single cell. Lotus 1�2�3 does not allow you to mix fonts and attributes in cells.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 has separate dialog boxes for formatting cells. Options such as number format, font and attributes, lines, and color, are found in the Style menu. Using the Formatting Cells tab dialog box in Microsoft Excel, you can access all of the formatting options with one menu selection.

Microsoft Excel Samples

�



Illustrated above is the shortcut menu that pops up when you use the right mouse button to drag-and-drop. You can easily perform specialized copy and move functions using this.



�

 

Microsoft Excel is the only spreadsheet offering Rich Text, as illustrated above.

Using Worksheets

Microsoft Excel

In Microsoft Excel 5.0 multiple worksheets are organized into workbooks, with tabs at the bottom to simplify navigation and organization. The number of worksheets in a workbook is limited only by the memory in your computer. With the workbook you can perform group edits by selecting multiple worksheets with your mouse. You can then format columns, define the page setup, and perform other functions to all of the selected sheets at once. 

Using workbooks, you can easily develop 3-dimensional formulas across worksheets. File management activities are also simplified; for example, you can save and print the entire workbook. Workbooks are the default document type in Microsoft Excel 5.0. 

A workbook can contain a variety of sheets. The four sheets found in a workbook are:  worksheets, charts, Visual Basic�SYMBOL 228 \f "Symbol"� Applications Editions modules, Microsoft Excel 4.0 macro sheets. Having different types of sheets helps you to organize and manage your work. Additionally, the sheets have different characteristics based on the type. For example, a Visual Basic module sheet is an editor providing an easier way to write your code. The charting sheet helps you to orient your chart on a printed page.

Lotus 1�2�3

Lotus 1�2�3 offers 3-dimension organization, allowing up to 256 worksheets in a file. Initially, Lotus 1�2�3 opens with only one worksheet in a file with a single tab on the top of the worksheet. Files can be added by clicking the New Sheet button. You can format specified worksheets by selecting the tabs, or format all of the worksheets by selecting Worksheet Defaults from the Style menu.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel allows you to change the order of the worksheets in your workbook by simply clicking on the tab and dragging it to a new location. Lotus 1�2�3 does not allow you to change the order of the worksheets.

�SYMBOL 183 \f "Symbol" \s 10 \h�	The group edit capability in Lotus 1�2�3 lets you apply only formatting to multiple worksheets. You are able to select specified files by clicking the tabs;  a black line appears to show which have been selected. However, when you move between sheets these selections are cancelled.

	Grouping sheets in Microsoft Excel is much simpler and offers more capabilities. Using group edit, you can format, write formulas and change the cell contents of all the selected sheets. Selected sheets are clearly indicated because the tabs turn from gray to white. You can easily move between worksheets while they are grouped and perform group edits until you cancel the worksheet selection.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 opens files with only one worksheet; whereas Microsoft Excel opens with as many worksheets as you specify (16 is the default). If you would like more sheets in Lotus 1�2�3, you will need to insert them, which requires more keystrokes. 

	Microsoft Excel allows you to have as many worksheets in a workbook as you would like; this is constrained only by the amount of available memory. Lotus 1�2�3 limits you to 256 worksheets in file.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel offers multiple sheet types that help you organize your work and information. Lotus 1�2�3 does not have different sheet types. 

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose New to open a new workbook. Select cell A1 of Sheet1, type: 1

	 Select the Sheet2 tab at the bottom of the screen. Select cell A1 of Sheet2, type: 2

	Select the Sheet3 tab at the bottom of the screen. Select cell A1 of Sheet3, type: 3

�SYMBOL 183 \f "Symbol" \s 10 \h�	Select the Sheet4 tab. Make cell A1 active. Click the AutoSum button found in the middle of the upper toolbar. You will see @SUM() in the edit box. Type: Sheet1:Sheet3!A1

	This should appear between the (). Press enter;  	The sum of those sheets, 6, will appear in cell A1 of Sheet4.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Holding down the ctrl key, select the tabs for Sheet1, Sheet2 and Sheet3. You will still be in Sheet4, but now the tabs for Sheet1 through Sheet4 will be white. Now, make sure cell A1 on Sheet4 is active. Click the Currency Style ($) button on the Formatting toolbar. Make other formatting changes such as clicking the Bold button, or changing the background color. Now choose one of the other worksheet tabs to move to another sheet. When you go to the other sheet you will see the formatting has changed for cell A1 in that sheet also.

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose Close. Choose the No button when asked if you would like to save.

Creating a Series

Microsoft Excel

Microsoft Excel pioneered the AutoFill feature which completes a series for you based on initial values you enter. AutoFill can be used through a menu option or by selecting the initial entry and dragging the AutoFill handle in the direction you would like filled (up, down, right, or left). Microsoft Excel will complete your series based on the data type and incremental changes between cells. Microsoft Excel can also complete your series based on custom lists, such as business contacts, product numbers, etc. 

Microsoft Excel 5.0 also allows the user to select different options for AutoFill by using the right mouse button. This will bring up a context-sensitive menu at the destination allowing you to set options. AutoFill was simplified further by allowing the user to double-click the AutoFill handle to complete a column of information. Microsoft Excel will sense where your information ends and complete the series to that point. 

Lotus 1�2�3 for Windows

Lotus 1�2�3 allows you to fill a range by example. You first enter a value, then  select the range that incudes the data and the cells you want to fill, and click the Range Fill button on the toolbar or choose Fill from the Range menu. Lotus 1�2�3 will fill in the highlighted cells based on your entries. Lotus 1�2�3 also provides capabilities to develop custom lists. To develop a custom list, access the Notepad in the Windows accessories menu. Open the FILLS.INI file in your Lotus directory. Enter your data by starting each list with [SET#] and preceding each item with ITEM#=

Differences

�SYMBOL 183 \f "Symbol" \s 9 \h�	To create a custom fill list in Microsoft Excel, you simply use the Custom Lists tab in the Options dialog box and type your list. Microsoft Excel will then complete your custom series when you drag the AutoFill handle, exactly as it completes other series. 

	In Lotus 1�2�3, you must go to the Windows Notepad and edit the FILLS.INI file. Special codes are used to indicate the position of the item in the list. After the FILLS.INI file has been modified, you must restart Lotus 1�2�3 to have it recognize your new list. This method is more complex than the solution offered by Microsoft Excel.

�SYMBOL 183 \f "Symbol" \s 9 \h�	Microsoft Excel allows you to fill directly on your worksheet by clicking the AutoFill handle and dragging across the cells you wish to fill. In Lotus 1�2�3, you must leave the worksheet to click the Fill By Example icon in the toolbar.

�SYMBOL 183 \f "Symbol" \s 9 \h�	Lotus 1�2�3 allows you to automatically fill ranges containing rows and columns. In Microsoft Excel, you can apply the AutoFill feature to a range of rows or columns.

�SYMBOL 183 \f "Symbol" \s 9 \h�	Microsoft Excel provides a shortcut menu with options for filling, easily accessible by using the right mouse button. Lotus 1�2�3 does not have a shortcut menu with options specifically for fill by example.

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose New to open a new workbook. Make cell A1 active and then type: Qtr1

	 Move the cursor to the bottom right corner of cell A1 where the cursor will become a solid black cross.  This indicates you have the AutoFill handle. Holding down the mouse button, drag the selected area to cell D1. When you release the mouse button, Microsoft Excel will automatically complete the series.

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the Tools menu, choose Options. A tab dialog box will open, select the Custom Lists tab in the Options dialog box. “New List” will be highlighted in the Custom Lists box. Click in the empty List Entries box and type any list (for example, the names of your family members). Press enter after each entry. When you are finished, choose the OK button.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Make cell A4 active. Type one of the items you just entered in your list. Again select the AutoFill handle at the bottom of cell A4 by holding the mouse button. Drag your mouse down any number of rows. When you release the mouse button, Microsoft Excel will complete your custom list in the order you specified.

Summing

Microsoft Excel

Microsoft Excel version 3.0 introduced the AutoSum�SYMBOL 228 \f "Symbol"� feature which proposes an area to be summed and then automatically adds those numbers.  Microsoft Excel 5.0 further improves this functionality so that it automatically gives you all row and column sums when you select the area and click the AutoSum button. The AutoSum feature is now truly intelligent. It supports summing a range of nonadjacent cells, recognizes when subtotals are present and calculates the grand total correctly, and will add only the visible cells if you collapse a worksheet using the Outline capability.

Lotus 1�2�3 for Windows

Lotus 1�2�3 includes a summing button on the toolbar. By clicking this once, Lotus 1�2�3 will input the sum of the numbers near the selected cell. Lotus 1�2�3 will also sum the rows and columns of a table when you select the area and click the sum button. 

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	When you click the AutoSum button, Microsoft Excel will first propose an area to sum, allowing you to change it or add non-adjacent cells if you like. In Lotus 1�2�3, when you click the sum button it sums the nearest data and does not allow you to change the selected area. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Automatic summation in Microsoft Excel is more flexible because it is not restricted to cells immediately above or to the left of the destination cell, as in Lotus 1�2�3.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3's summing feature does not recognize subtotals. If you have a list of numbers with subtotals in the middle and then attempt to add the grand total at the end, you will not get the correct value because the summing button will include every number in the calculation. Microsoft Excel, on the other hand, recognizes subtotals in a list and will correctly sum the numbers when you insert a grand total at the end.

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	Select a clean sheet by clicking on one of the worksheet tabs. Type any numbers in cells A1, B1 and C1. Make cell D1 active. Click the AutoSum button on the toolbar. Microsoft Excel will propose the area A1:C1. Click AutoSum again to accept this range. The sum is calculated.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Type any numbers in cell A2, B2 and C2. Make cell A1 active. Hold down the mouse button and drag from cell A1 to cell D3. Release the mouse button, the range will be selected, then click the AutoSum button. Microsoft Excel will automatically insert row and column sums.

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose Close. Choose the No button when asked if you would like to save.

Managing Data

Microsoft Excel

Microsoft Excel 5.0 offers many features that help you manage basic lists of information. The enhanced sort feature automatically finds the relevant data in the worksheet based on one active cell location. When you select Sort from the Data  menu, a dialog box appears so you can choose the categories by which to sort. If you have used column headings in your list,  Microsoft Excel will recognize these as the categories, so you can select sort criteria based on your own terms. Additionally, you can sort non-alphabetically by defining a custom list. When sorting, Microsoft Excel will not include your headings.  To help you repeat a sort, Microsoft Excel remembers your last sort definition and maintains the correct settings.

For simple sorts, based on only one sort criteria, Microsoft Excel offers Sort Ascending and Sort Descending buttons on the toolbar. Simply activate one cell in the column of data you would like to use as the sort criteria. When you select either of the Sort buttons, Microsoft Excel will identify the complete list of information, sort based on the selected cell, and leave your column headings intact.

If you want to see a subset of your information, based on certain criteria, you can use AutoFilter. When you choose AutoFilter from the Data menu, Microsoft Excel automatically finds the relevant list in the worksheet, identifies field names by column headings, and converts each column heading to a drop-down list directly on the worksheet. The lists show each data item represented in that column. These lists give you a direct way to perform simple queries. Microsoft Excel also offers the Advanced Filter option which offers traditional database functions such as setting criteria and extract ranges.

Lotus 1�2�3 for Windows

Lotus 1�2�3 has capabilities for sorting either by range or a query table. To sort a range of information, select the range you would like to sort, making sure not to include the column headings, and choose Sort from the Range menu. A dialog box will appear that allows you to enter the cell number of the range by which you would like to sort.

Query Sort offers improved sorting capabilities. First choose Database from the Tools menu.  From the Database menu, choose New Query. In the New Query dialog box you will select the range of data you would like sorted and select a location for the query table. Once you have created the query table, choose Sort from the Query menu. The Query Sort feature will recognize your column headings in Lotus 1�2�3 and these headings will not be sorted with your other data.

You are able to see a subset of your data by creating new query tables. From the Tools menu, choose Database. From the Database menu, choose New Query. In the New Query dialog box, you must select the database range, choose the fields to be included in your query, set the criteria, and define a location for the query table. Lotus 1�2�3 offers other traditional database capabilities in addition to query such as Find Records, Delete Records, and Append Records.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel offers a one-click step to perform simple sorts in either ascending or descending order. Lotus 1�2�3 does not have this capability.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel bases the sort criteria on your terms (i.e. Product, Sales) because it recognizes and uses your column headings. Lotus 1�2�3 uses cell addresses (i.e. B1, D3) to select the criteria in the Sort dialog box.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel will automatically select the range to sort based on one active cell. In Lotus 1�2�3, you must define the sort range by selecting the area using your mouse. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	In Lotus 1�2�3, you must be careful not to select the column headings when performing a Range Sort or they will be included in the sort. Microsoft Excel is intelligent enough to recognize column headings, use them as categories, and not include them in the sort. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel will perform custom sorts, that are not alphabetical, based on your custom lists. Lotus 1�2�3 only performs alphabetical and numerical sorts.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel offers a much simpler and more intuitive way to view subsets of your data. AutoFilter puts drop-down lists directly on your worksheet so you can view subsets in place, based on criteria selected from the lists. When you are finished, simply turn AutoFilter off and you will return to your full list. Lotus 1�2�3, however, requires you to set a database range and define a new table to perform simple queries.

Microsoft Sample Exercises�

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose Open. The File Name box will be selected, type: *.*

	 Press enter. Double-click the top folder in the Directories list. This should be the hard drive, usually C:\

	Use the scroll bar on the right of the box to move down the list. Double-click the Windows folder.  Double-click the MSApps folder. Scroll down and double-click the MSQuery folder. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	In the File Name list select ORDERS.DBF and choose the OK button. Now that you have retrieved ORDERS.DBF, select any cell in the table. From the Data menu, choose Sort. A dialog box will appear. The first item will say “Sort By”. Click the arrow of the Sort By box and select EMPLOY_ID from the list. Click the arrow of the Then By box and select CUSTMR_ID. Choose the OK button. The list is now sorted by employee.

�SYMBOL 183 \f "Symbol" \s 10 \h�	To see how many customers are in California, we will use AutoFilter. From the Data menu, choose Filter. A cascading menu will appear to the right;  select AutoFilter. Drop-down list arrows will appear in the column headings. Press tab to move to the right until you reach column G. Select the arrow in the SHIP_REGN column heading, cell G1. Click “CA” in the list. Your table should now only contain the California orders.

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose Close. When Microsoft Excel asks you if you would like to save, choose the No button. 

Summarizing Data

Microsoft Excel

Microsoft Excel is the only spreadsheet that provides Outlining for managing different views of data. An outline can be created either by choosing Group And Outline from the Data menu or by performing certain functions, such as subtotals, which automatically create outlines. Outlines will organize your data in up to eight levels of information, both horizontally and vertically. The outline function will create collapse and expand symbols that you click to display the level of detail you would like to see. After you have hidden rows or columns by collapsing the outline, commands will apply to only the visible cells. Outlining makes it faster and easier to browse spreadsheets and create summary reports.

Automatic Subtotals is another new, intelligent feature. When you choose Subtotal from the Data menu, Microsoft Excel automatically highlights the relevant list in the worksheet based on one active cell location, identifies field names from the column headings, and displays these field names in the Subtotal dialog box. You can choose the type of subtotal desired (i.e. sum, count, average) and create multiple subtotals for each group in a sorted list. Microsoft Excel automatically inserts rows at each group break in the list and enters the subtotal formulas. Microsoft Excel also calculates the grand total. You can easily remove all subtotal formulas from a list by choosing Remove All in the Subtotals dialog box. Subtotals will automatically create an outline, making the subtotaled list easy to browse at different levels of detail.

Lotus 1�2�3 for Windows

Query Aggregate in Lotus 1�2�3 will produce subtotals for a query table. To do this, you must define a query table from a database and remove fields when building the query table in order to obtain the results you want. By choosing Aggregate from the Query menu, you can perform one of the following operations on the selected field:  sum, average, count, min and max.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 does not offer an outlining feature.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 requires a separate query table to perform a subtotaling action. You must be careful when creating the query table to include only the appropriate fields. In Microsoft Excel, you can subtotal your list of information without creating another table. Microsoft Excel is intelligent enough to understand your data and you are able to choose the field to subtotal from the dialog box. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	In Lotus 1�2�3 you can select only one type of subtotal for your query table. In Microsoft Excel, you can have multiple subtotals. For example, if you have a list of sales people with their monthly sales revenue, you can easily see the total sales for each person and the average sales for each person. 

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	Follow the instructions in the first bulleted item of the Sample Exercise on page �pageref open_msquery�21�.

�SYMBOL 183 \f "Symbol" \s 10 \h�	In the File Name list select ORDDTAIL.DBF and choose the OK button. Make any cell in the worksheet active. From the Data menu, choose Subtotals. This will bring up the Subtotals dialog box. In the At Each Change In box select ORDER_ID. In the Use Function box select SUM. In the Add Subtotal box, select QUANTITY. Cancel all other options. Choose the OK button. Notice, you now know how many of each item you sold.

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the Data menu, choose Subtotals. In the Use Function box select AVERAGE. In the Add Subtotal box, select UNIT_PRICE. Click QUANTITY to cancel that item. Select the Replace Current Subtotals option, then choose the OK button. Notice, you now have two subtotal values for each order.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Click the small 2 button at the top-left of your screen. Notice how the table collapses so you only see the subtotals. Now click any (+) at the left of the row numbers. This Show Detail symbol will expand the outline so you can see the data. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose Close. Do not save the changes.

Data Access and Analysis

Organizations are flooded with information on a daily basis. Your spreadsheet must help you manage and make sense of this data. You need powerful tools that facilitate the process of gathering and analyzing facts.

Importing and Parsing Text

Microsoft Excel

Users often need to bring text into their spreadsheets from other systems and programs. Microsoft Excel developed the TextWizard to simplify this task. When you open a text file in Microsoft Excel, the TextWizard automatically appears. The TextWizard walks you through a set of options to determine exactly how the file will be imported. It automatically recognizes the layout of the file and offers a preview of the data. Using the preview as your guide, you can select the row at which to start importing, determine column breaks and widths, set data types, and manipulate fields.  If you are copying text data to a worksheet, the Convert Text to Columns Wizard will guide you much like the TextWizard.

One important capability of this feature is parsing. Through our company visits, we saw many customers importing mainframe reports into Microsoft Excel. Many times, customers had fields, such as a part number, that they wanted to split. For example, Encore Musical Instruments might have a part number 12345-1234. The first part of this indicates stock location and the second part indicates product number. Microsoft Excel made it easy to divide this number in half, specifying the “-”as a delimiter. This is a simple procedure that the TextWizard guides you through.

Lotus 1�2�3

Lotus 1�2�3 will import text into columns with the File Open command only if the text is correctly formatted, with “ ” around labels and the proper delimiters between fields. You can also combine correctly formatted text files with a worksheet by using File Open Combine and selecting the text file. If your text data is already in the worksheet, you can select the range and select Range Parse from the menu bar. A dialog box will appear and will ask you to input a format line that describes the layout of the data. Lotus 1�2�3 will create a sample format line for you by choosing the Create button. You can then accept this format or modify it if it is not correct.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	To open a text file in Lotus 1�2�3, the file must be formatted correctly. If it is not, it will import as text in one column. Lotus 1�2�3 does not ask you about the format or allow you to preview the data. The TextWizard in Microsoft Excel gives you much more control when importing text and guides you through the formatting steps. You can preview how your data will look and ensure the layout is correct.

�SYMBOL 183 \f "Symbol" \s 10 \h�	The Range Parse command lets you parse text once it is in Lotus 1�2�3, but to do this correctly you must be familiar with the codes used in the format line. Although Lotus 1�2�3 can create a sample format line for you, it can be very confusing to modify because the codes are not intuitive. A sample format line is L>>>>*L>>>>***D>>>>>>. This represents two labeled fields and a date field.

	Microsoft Excel uses the Convert Text to Table Wizard to step you through the process. You can see how your data looks as you tell Microsoft Excel what delimiters you have used, and can define the field types.

�Microsoft Excel Sample

�



Example of TextWizard.

Accessing External Databases

Microsoft Excel

Microsoft Query is the query tool available in Microsoft Excel. It is based on the query component of Microsoft's award winning Microsoft Access™ for Windows database management system. The tool will allow for viewing, querying, and editing data that you import from other databases. Microsoft Query utilizes the Open Database Connectivity (ODBC) standard allowing access to a wide variety of data sources. The ODBC drivers shipping with Microsoft Excel 5.0 include:  Microsoft Access versions 1.0 and 1.1; FoxPro™ versions 2.0 and 2.5; dBASE III™ and dBASE IV™; Oracle™; SQL Server™; Paradox™ 3.0 and 3.5; Microsoft Excel versions 3.0 and 4.0 databases. In addition, because ODBC is an industry standard, database programs will supply drivers compatible with Microsoft Excel and other products that support ODBC.

Microsoft Query lets you view the data as you format and manipulate it, much like the TextWizard. The preview ensures that the data imports into Microsoft Excel correctly and as you expected.

Lotus 1�2�3

You can connect to a database file outside of Lotus 1�2�3 and work with it as you work with a Lotus 1�2�3 database table. To connect to an external database you can choose Database from the Tools menu and then choose Connect To External.  Or, use the External option in the New Query dialog box. Lotus 1�2�3 uses DataLens® drivers to access data in external database tables. To connect to an external database table, you must know the name of the appropriate DataLens driver and the name of the table. Lotus 1�2�3 includes DataLens drivers for Paradox, dBASE IV, SQL Server, Informix and IBM Database Manager.

Lotus 1�2�3 is able to translate ODBC drivers to the DataLens format so you are able to access ODBC databases indirectly.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel supports the ODBC industry standard directly. Lotus 1�2�3, on the other hand, must translate the ODBC drivers. This translation process provides an additional opportunity for errors.

�SYMBOL 183 \f "Symbol" \s 10 \h�	DataLens drivers are unique to Lotus 1�2�3; the industry does not support this format. The ODBC format, which Microsoft Excel utilizes, is an industry standard. A large number of database vendors write ODBC drivers.

Microsoft Excel Sample
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Illustrated above is Microsoft Query, the tool used to access external databases in Microsoft Excel.

Using Functions and Formulas

Microsoft Excel

For more advanced calculations, Microsoft Excel offers over 300 mathematical, database, date and time, statistical, and financial functions. To help you in using these functions, Microsoft Excel 5.0 introduces the Function Wizard which provides detailed information about the functions and steps you through completing the arguments. The Function Wizard is integrated with Help topics and provides a Help button right on the dialog box. It also has a category of Most Recently Used functions, which is a self-customizing list of the user's favorite functions. You can easily activate the Function Wizard by clicking the button on the toolbar. 

Microsoft Excel also offers array capabilities. Array formulas can save you time if you find yourself entering the same formula in adjacent cells and changing just the formula's cell references to match the new row or column. Entering a formula as an array can also reduce the amount of memory used by your worksheet. When you enter an array formula, you enter one formula for all the cell ranges on which you want to perform the same operation or set of operations.

Lotus 1�2�3 for Windows

Lotus 1�2�3 provides a set of more than 200 built-in formulas called @functions activated by an @function button on the toolbar. When clicked, this provides a menu that lists common functions, and also an option to list all of the @functions. The dialog box listing all of the functions has a Help button to take you directly into help. When you select a function, Lotus 1�2�3 will place the function and placeholders for the arguments in the active cell. 

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	The Microsoft Excel Function Wizard guides you through completing the arguments of the function you select. Lotus 1�2�3 does not offer this and requires you to complete the arguments on your own.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 does not offer array formulas.

Microsoft Excel Sample
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Above are samples of the Function Wizard which guides you through completing arguments of functions.

Analyzing Multi dimensional Data

Microsoft Excel

Microsoft Excel enables you to create summary tables of multidimensional data called Pivot Tables. For example, a pivot table, as pictured below, will let you display revenues for each product by country. Creating a pivot table is easy because the PivotTable Wizard walks you through the setup process, helping you to identify the data source and select the categories you want to display. The PivotTable Wizard works on a variety of external and internal data types using Microsoft Query. Once the pivot table is established in a worksheet, you can alter the category display by dragging and dropping the column names (i.e. Country, Product). 

�

In the illustration above, the data is shown on a monthly basis. You can easily change the reporting period by grouping the data. With two clicks, pivot tables will alter the display from monthly to quarterly. Microsoft Excel will group the months correctly and sum the revenues to get quarterly revenue information. In addition, you can have the body of information represented in different formats such as total revenue dollars, sales as a percentage of the total, etc. 

Pivot tables offer a drill down feature that allows you to double-click a data element and see a list of individual records that make up that value. You can also create 3-dimensional formulas to consolidate information provided on many sheets.

Lotus 1�2�3

Lotus 1�2�3 does not offer a multi dimensional dynamic analysis feature like pivot tables. Improv®, another products made by Lotus, do offer this feature but must be purchased separately from Lotus 1�2�3. 

Lotus 1�2�3 does offer a cross-tab capability that will create tables for 2-variable and 3-variable cross-tabulations. To do this you must create a cross-tab table, use database @functions to identify the input ranges, field names, and criteria ranges. When you have successfully set up the table, you calculate the cross-tab by choosing  What-if Table from the Analyze menu.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Because Improv is a separate product, you must construct your data in Lotus 1�2�3 following a rigorous methodology to achieve the category drag-and-drop capability. Improv's rigidity makes it difficult to create reports with existing spreadsheet data.

	Microsoft Excel, on the other hand, offers pivot tables that are integrated into the product and are easy to set up using the PivotTable Wizard.

�SYMBOL 183 \f "Symbol" \s 10 \h�	The cross-tab option in Lotus 1�2�3 offers static representation of 2- and 3- dimensional data only. Pivot tables in Microsoft Excel will represent any number-variable tables, and are dynamic. By simply dragging field names to different locations on the table, you can look at your data in different ways.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Creating cross-tabulation tables in Lotus 1�2�3 is very complex and requires the use of @functions, ranges, input values, etc. Microsoft Excel uses a PivotTable Wizard to simplify the process of creating pivot tables. The Wizard will walk you through the steps in a very clear manner.

Microsoft Excel Sample Exercises

1.	From the File menu, choose Open. The File Name box will be highlighted, type: *.*

	Press enter. Double-click the top folder in the Directories list. This should be the hard drive, usually C:\ . Use the scroll bar on the right of the box to move down the list. Double-click the Windows folder.  Double-click the MSApps folder. Scroll down and double-click the MSQuery folder. 

2.	In the File Name list select ORDERS.DBF and choose the OK button. Select the Sheet1 tab using the right mouse button. In the shortcut menu, choose Insert. Select Worksheet from the list. Choose the OK button. Sheet2 will be added to your workbook; select the tab for Sheet1.

3.	Once you have returned to Sheet1 and the Orders data, select cell A1. From the Data menu, choose PivotTable.

4.	The PivotTable Wizard will appear. In Step 1, choose the Next button to accept the 'Microsoft Excel List or Database' option. In Step 2, choose the Next button to accept Database in the Range box.

5.	Step 3 of the PivotTable Wizard will display an empty table with all of the column headings from the database to the right. To start, press the mouse button while on the EMPLOY_	 button, drag it to the Row portion of the empty table, release the mouse button. Now, drag SHIP_CNT to the Row portion also; when you release the mouse button, it will be placed under EMPLOY_. Drag SHIP_VIA to the column portion. Drag ORDER_A to the data area, it will now say 'Sum of ORDER_AMT' on the button. Choose the Next button.

6.	At Step 4, select the Sheet2 tab and select cell A1. After you have done this, 'Sheet2!$A$1' will appear in the Starting Cell box. Choose the Finish button.

7.	You now have a Pivot Table and are able to see what each employee's orders are by country and ship route. To change the view, select the SHIP_CNTRY button and drag your mouse so the cursor covers EMPLOY_ID. When you release the mouse button, the values have switched places so you can see orders by country.

8.	Finally, click EMPLOY_ID and drag the cursor up so it is covering the column heading B. When you release the mouse, a drop-down list box will appear. Click the down arrow to see a list of the employee values. By selecting different employee numbers, you can see individual orders.

9.	From the File menu, choose Close. Choose the No button when asked if you would like to save.

Performing What-if Analysis

Microsoft Excel

Microsoft Excel includes several tools you can use to explore the effects of variables on a set of assumptions. Often you know the result you want a formula to return, but not the input values the formula needs to reach that result. Goal Seek will solve these single variable problems by trying values for that variable. The Solver is an add-in application that gives you similar control over multiple-variable problems. The Solver will take into account many input values, results and constraints. It uses well-established numeric methods for equation solving and optimization. For example, Solver will help you to determine how to maximize profit or minimize costs based on certain variables and constraints you determine.

Another “what-if” analysis tool in Microsoft Excel is data tables which provide a shortcut for calculating all the variations in one operation. A data table is a range of cells that shows the results of substituting different values in one or more formulas. Data tables will either calculate formulas based on one variable or two variables. 

Microsoft Excel 4.0 introduced the Scenario Manager, which you can use for further “what-if” analysis by creating a set of values for certain cells in your worksheet. Scenario Manager allows you to create  multiple scenarios, view the results of using a scenario in your worksheet model, and create a report that provides a summary of all input values and results for the scenarios you have created. This report can either be in the form of a spreadsheet table or in a pivot table. By using a pivot table to summarize the scenarios, you can dynamically rearrange the data. This allows you to see the results if all the best-case scenarios are accurate or if all the worst-case scenarios are accurate, for example, by simply dragging and dropping column headings. 

Lotus 1�2�3

Backsolver works backwards from the result of a formula to find the values of one or more variables in the formula, very similar to Goal Seek in Microsoft Excel. You supply the formula result and specify which variable you want Backsolver to change to arrive at this result. Lotus 1�2�3 also offers a Solver that will solve problems that you describe with algebraic and logical relationships in a worksheet. Solver will also allow you to maximize and minimize values using variable amounts and constraints.

In addition, Lotus 1�2�3 offers What-If tables which calculate the results of substituting different values in formulas. This feature, in the Range Analysis menu, will build tables on your worksheet that substitute values for one, two, or three variables in a formula. 

To perform advanced what-if analysis, Lotus 1�2�3 offers Version Manager which performs similarly to Scenario Manager in Microsoft Excel. Versions are sets of different data for the same named range. You are able to create and save multiple values for a range that can be replaced using the Version Manager facility. You can create versions of any named range in a field. A scenario is a named group of versions that apply to different ranges. This allows you to select certain versions of data you would like to use together and save them.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel lets you dynamically view the results of scenarios using pivot tables. Lotus 1�2�3 offers only static tables to view the results. This makes it difficult to combine different scenarios and see the resulting impact. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 allows you to group versions into scenarios. However, this is a static function and does not have the flexibility of dynamic groups made available in Microsoft Excel using pivot tables. 

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose Open. In the Directories box, double-click the Excel folder. Double-click the Examples folder. Double-click the Solver folder.

�SYMBOL 183 \f "Symbol" \s 10 \h�	In the File Name list, select SOLVEREX.XLS and choose the OK button. When the file has been retrieved, make cell B9 active. Select cells B9 to E9 by holding down the mouse button and dragging. From the Tools menu, choose Scenarios. In the Scenario Manager box choose the Add button. Your cursor should now be in the Scenario Name entry in the Add Scenario box.  Type: Normal Sales Cost

	Choose the OK button. At the Scenario Values box choose the OK button. You should be returned to the Scenario Manager box. Notice in the Scenarios list the name “Normal Sales Cost”.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Choose the Add button. Your cursor should be in the Scenario Name entry in the Add Scenario box.  Type Low Sales Cost

	Choose the OK button. At the Scenario Values box type 6000 in the first value box. Press tab. Type 6000 in the second value box. Press tab. Type 8000 in the third value box. Press tab. Type 8000 in the fourth value box. Choose the OK button. You should be returned to the Scenario Manager box. Notice in the Scenarios list the name “Normal Sales Cost” and “Low Sales Cost” now appear.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Click to select “Low Sales Cost” from the list. Choose the Show button. Move the Scenario dialog box by clicking in the title bar and dragging. Notice that the values in the table change. Select “Normal Sales Cost”from the list. Choose the Show button. The values have now returned to their original amounts. Choose the Close button in the dialog box to close Scenario.

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose Close. Choose the No button when asked if you want to save.

Working with Multiple Applications

Studies have found that the number of software programs per desktop has increased from 3.4 in the MS�DOS–based world in 1986 to 7.0 programs in the Windows operating environment today. Because of this trend, companies must ensure applications are consistent and integrated to reduce training needs and improve their ability to work together.

Applying a Consistent Interface Among Applications

Microsoft Excel

Consistency in a suite of products will reduce overall training costs and learning time. Microsoft has emphasized the importance of interface consistency in Microsoft Office, which includes Microsoft Word, Microsoft Excel and Microsoft PowerPoint�SYMBOL 226 \f "Symbol"�. The menus in these products were developed to be similar, so that 8 out of 9 menu titles are the same and they are located in the same place across applications. Additionally, drop-down menus, shortcut keys, and dialog boxes have consistent commands that are grouped similarly. We have also concentrated on creating toolbars that are similar, with common functions having the same button design and the same position on the toolbar. Finally, we offer a Microsoft family toolbar that provides “launch” icons allowing you to easily switch from one Microsoft product to another.

Lotus 1�2�3

Lotus SmartSuite™, which includes Lotus 1�2�3, AmiPro® and Freelance®, has 7 menu titles that are the same above each toolbar. Lotus' drop-down menus, shortcut capability and dialog boxes differ among applications. For instance, spell check is not found in the same place across applications. Additionally, each toolbar in Lotus has a different number of total menus and each menu bar is ordered slightly differently. 

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft has put an enormous amount of effort into standardizing the interfaces of Office applications. We realize the implications this has for businesses regarding training cost, time to complete a project, and basic ease of use. Lotus SmartSuite has not achieved this level of consistency. For instance, their menus offer similar commands but are organized differently. Below is an example of menu options in the Microsoft Office applications and menu options in the Lotus SmartSuite applications. 

�



	Microsoft Office Menu Bars

    �  



	Lotus SmartSuite Menu Bars 

��SYMBOL 183 \f "Symbol" \s 10 \h�	Using the toolbar allows you to work more efficiently. Tools are very visible guides to access commands. Common Microsoft tools appear the same across applications and are positioned in the same location. Additionally, we have adopted the standard ToolTips format for all applications, so you will quickly know what each button represents. Lotus SmartSuite has not been as consistent in their use of tools. Also, they have not integrated their tool definition, found in the title bar, across all applications. Following are samples of the toolbars available in the major applications.

�

�

�

 Microsoft Word, Excel and PowerPoint toolbars



�

AmiPro Default SmartIcon set



�

Lotus 1�2�3 version 4.0 Default SmartIcon set



�

Lotus 1�2�3 version 4.0 Working Together SmartIcon set

�

AmiPro Working Together SmartIcon set

Integration with Other Applications

Microsoft Excel

Microsoft Excel devoted 20% of its development effort toward making Excel work seamlessly with the Microsoft family of programs. Microsoft Excel, as all Microsoft Office products, supports OfficeLinks which makes it possible to easily share text, data and graphics between applications. Much of the capabilities available through OfficeLinks are because of Object Linking and Embedding (OLE) 2.0, an open standard that also enables third-party applications to be integrated into documents. 

By representing charts, tables, images, etc. as objects, users can more easily exchange, incorporate, and process data among applications. A standard set of services must be available to effectively control and manage these objects. OLE 2.0 offers a full suite of capabilities that can be applied to objects. A program may claim to support the OLE standard, but might not offer many of the functionalities available. Microsoft Excel offers a robust implementation of OLE 2.0. As a user, this means that you can seamlessly create compound documents.�

Visual Editing is available when using Microsoft Excel objects in other applications. As an example, you can embed a Microsoft Excel table in a Microsoft Word document. If you are working in the document and would like to update the table, you can simply double-click the table. With Visual Editing, double-clicking the object allows you to edit it while remaining in the document. The Microsoft Excel menus and toolbars will seamlessly appear, without completely switching applications. This allows you to still view your document while you are editing your table or chart and gives you all of the power, menus, and capabilities of Microsoft Excel.

Also because of OfficeLinks and OLE 2.0, Cross-Application Drag-and-drop is available. Now you are able to simply click your Microsoft Excel chart, table or other object and drag it directly into your Microsoft Word 6.0 document. Upcoming versions of other Microsoft Office applications will also support Cross-Application Drag-and-drop. You will no longer need to cut and paste or copy to the Clipboard. 

Lotus 1�2�3

Lotus products do not support OLE 2.0 but do support OLE 1.0 capabilities. Lotus 1�2�3 can either be the server, supplying the information to another application, or the client, receiving information from another product.

You are able to embed objects from other products into Lotus 1�2�3 using the Edit Insert command or Edit Paste command. Once embedded, you can double-click the object to run the client application and edit the original data.

The simplest way to create a link to another application from Lotus 1�2�3 is to copy and paste it, using Edit Copy and Edit Paste Link. Because you specifically select Paste Link, if the linked data in the server application changes, the data in the client application changes.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel offers Visual Editing which allows you to continue working in the client document, while the menus and toolbars change to the server application. This is a seamless transition for the user. In Lotus 1�2�3, when you double-click an object for editing, it opens the server application and abruptly jumps to that environment.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel supports Cross-Application Drag-and-drop. Currently, this capability is available in Microsoft Excel 5.0 and Microsoft Word 6.0. To embed an object in Lotus 1�2�3 you must copy the server object to the Clipboard and then use Edit Insert or Edit Paste in the client product. This is not as intuitive and requires many more steps than Cross-Application Drag-and-drop.

Microsoft Excel Sample

�

Above is an example of Visual Editing. When you click the table in your Microsoft Word 6.0 document, Microsoft Excel 5.0 is launched, the menu and toolbar items change, but you can still see your Microsoft Word document.

Sharing Resources among Applications

Microsoft Excel

To maximize hard disk space and ensure consistency, Microsoft applications share common functions. Because these functions are shared, they need to be installed only once for all applications. Many Microsoft applications share the following resources:

�symbol 183 \f "Symbol" \s 10 \h��	Spelling Dictionary	

�symbol 183 \f "Symbol" \s 10 \h��	Custom Dictionary	

�symbol 183 \f "Symbol" \s 10 \h��	Microsoft Info	

�symbol 183 \f "Symbol" \s 10 \h��	Microsoft Query	

�symbol 183 \f "Symbol" \s 10 \h��	WordArt	

�symbol 183 \f "Symbol" \s 10 \h��	Microsoft Graph	

�symbol 183 \f "Symbol" \s 10 \h��	Microsoft Draw	

�symbol 183 \f "Symbol" \s 10 \h��	Visual Basic	

�symbol 183 \f "Symbol" \s 10 \h��	ODBC Drivers	

Lotus 1�2�3

Lotus applications share code only for the spell checker.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Because Microsoft products share functions, you will conserve disk space when you install multiple applications. In Lotus products, however, redundant functions and code will be installed, increasing the amount of total space required. 

Customization and Programmability

Creating solutions specific to your company's needs will enhance productivity. Your spreadsheet should support this activity from a very basic level to a very advanced level.

Developing Macros

Microsoft Excel

Microsoft products will all be using a common macro language, Microsoft Visual Basic Programming System, Applications Edition. This will greatly reduce the learning time previously required when each product had its own unique macro language. Microsoft Excel offers a macro recorder that will allow you to record macros in Visual Basic. This will be an effective learning tool for people new to Visual Basic. For those who need to work with the old language, simply change an option and the macro will be recorded in the .XLM language. Macros are automatically recorded on a separate sheet in the workbook which is labeled with the macro name.

Visual Basic has many advantages as a macro language. First, it is based on the popular Visual Basic language which has been used to create more than 455,000 applications. Second, it is very powerful and will allow you to control OLE 2.0 objects from various applications. Lastly, it includes a complete integrated development environment with a compiler, UI tools, debugging tools, editor, and sample code.

Lotus 1�2�3

The Lotus 1�2�3 macro language has more than 200 macro commands. These commands can automate menu choices and perform programming functions. Lotus 1�2�3 has a macro recorder that will record your keystrokes. You decide where the macro will be located either in a worksheet file with other data or in a macro library, a worksheet file that contains only macros. The standard macro language used is unique to Lotus 1�2�3.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel will automatically generate a separate sheet for your macro and label it with the title. This sheet is specifically designed to edit macros. You do not need to manually designate an area in your worksheet or in the macro library, as in Lotus 1�2�3.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft's common macro language strategy will reduce training time. Additionally, Visual Basic will offer powerful new capabilities, such as OLE 2.0 support. 

	Lotus 1�2�3 uses a macro language specific to that product which does not follow any common syntax rules. It also is not common among applications and does not support OLE 2.0.

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose New to open a new workbook. While in Sheet1, choose Record Macro from the Tools menu. A cascading menu will appear at the right;  choose Record New Macro. In the Record New Macro box type your name as the name of the macro and choose the OK button. A Stop button will appear on the sheet.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Again, choose Record Macro from the Tools menu. This time, choose Use Relative References from the cascading menu. Now, select the tab for Sheet3. Make cell C1 active. Type your name in the cell and press the down arrow once. Click the Stop Macro button.

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the Tools menu, choose Macro. The Macro dialog box will appear. Highlight your name in the Macro Name/Reference list by clicking it.  Choose the Edit button. Take a look at the Visual Basic code. When you are finished click the small triangle button on the bottom far-left of your screen.  This will take you to the beginning of the tabs. 

Customizing Your Worksheet

Microsoft Excel

Customizing your worksheet can simplify any task you do on a regular basis, such as creating monthly reports. Microsoft Excel offers tools that can be easily added to your spreadsheet. You can place On Sheet Controls, such as edit boxes, buttons, list boxes, etc., on your worksheet with a simple click of the mouse. You then assign a macro to each control. With this capability, you can easily put buttons on sheets to jump to graphs of tables, show more detailed information of the current view, and switch to other applications.

Using the Dialog Editor, found in the Macro option of the Insert menu, you can draw dialog boxes and easily associate properties and macros directly with dialog box objects. You can also interactively create a custom menu command and assign a macro to it. Menu Editor creates or edits menus that can be applied globally or be associated with a particular workbook.

Microsoft Excel 3.0 introduced toolbars. With Microsoft Excel 4.0, you could customize these toolbars by adding new buttons. Microsoft Excel 5.0 introduces the Toolface Editor allowing you to truly customize your toolbar buttons. Using this editor you can change the appearance of a button by changing the color or design. This allows you to create custom buttons specific to the needs of your employees and projects.

Lotus 1�2�3

Lotus 1�2�3 allows you to place a button on your worksheet by choosing the Draw button from the Tools menu. You then assign a macro to this button to perform the action you would like. You can also assign a macro to an icon and create your own bitmap for the icon. To create the bitmap for your icon you can copy the bitmap of an existing icon and edit it, start with a blank button and paint your own bitmap, or copy a bitmap to the Clipboard from another application and paste it into a blank icon.

You can use the Lotus Dialog Editor, an additional application that you can select to install during setup, to create and edit custom dialog boxes. With the Lotus Dialog Editor, you can create a dialog box with list boxes, radio buttons, buttons, editing boxes, etc. The box you create is displayed in Lotus 1�2�3 using the {DIALOG} macro. The {DIALOG} macro also assigns the actions to take when a control in the Dialog Box is selected. 

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel has more controls that can be placed directly on your worksheet; Lotus 1�2�3 only offers a button.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 has a separate application to draw the dialog box. In addition, macros are not assigned directly to each control in the dialog box. This is done using the {DIALOG} macro which consists of a large table with many columns of codes. 

	Microsoft Excel allows you to create dialog boxes within the application and attach macros to each control, as with on sheet controls. This is a much simpler method to develop dialog boxes and does not require you to switch out of your spreadsheet program.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 does not offer a Menu Editor, as Microsoft Excel does.

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	We are going to use the macro you created above and add a button to your worksheet. Select the tab for Sheet1. Move the mouse to the toolbar and click with the right mouse button. This will activate the toolbar options.  Select Forms. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	A toolbar will appear; select the fourth button, ToolTip will say “Create Button”. Move the mouse to the sheet and draw the size button you would like by dragging the mouse and releasing the mouse button when you are finished. The Assign Macro dialog box will appear. Double-click your name in the Macro/Name Reference list. Hold down the mouse button and select “Button 1” on the button and type your name. Click anywhere on the worksheet.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Now, click your button. After you see the macro execute, you may return to Sheet1 and click again. Double-click the top-left corner of the Forms toolbar to close it.

	From the File menu, choose Close. Choose the No button when asked if you would like to save.

Building Custom Solutions

Microsoft Excel

Visual Basic provides a familiar coding environment because it is based on Visual Basic, a popular language. Visual Basic offers helpful programming aids such as a Built In Debugger which allows users to set breakpoints in their code, skip steps during execution, and set watch points and variables. These tools make it easy to find errors in the code, make changes during code execution and create a fully debugged application.

Because Visual Basic is a more powerful language than traditional macro languages, and provides tools necessary for development, you will be able to create custom solutions for your business more quickly. 

In addition to Visual Basic, Microsoft Excel supports an Applications Programming Interface (API). The API provides the tools to create functions and commands in a high-level language such as C or Pascal. 

Lotus 1�2�3

The Lotus 1�2�3 macro language is not based on a standard programming package. Lotus 1�2�3 does offer Step mode and Trace to help in debugging macros. Using Step mode, you can run a macro one command at a time. Trace opens the Macro Trace window which displays the macro command that 1�2�3 is about to perform.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Because the macro language for Microsoft Excel is based on a popular programming language, Visual Basic, there are many programmers and developers who are already very proficient in this language. There are approximately 350,000 Visual Basic developers worldwide. It is more intuitive and powerful than macro languages and is based on standard syntax. 

	Lotus 1�2�3 offers a traditional macro language with specialized syntax not based on a common programming language. This makes training more lengthy and limits the number of experienced developers.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Visual Basic is a full programming language and offers many tools to help in development. The debugger is sophisticated and will allow you to monitor variables. Lotus 1�2�3 does not offer a full debugger, it has only two modes to help in identifying problems.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Visual Basic allows you to set breakpoints and skip steps when using the debugger. Lotus 1�2�3 offers only a step-by-step debugging mode.

Microsoft Excel Sample

�



Built-in Debugger for Visual Basic

Using Other Applications

Microsoft Excel

OLE 2.0 was described briefly on page �pageref integration_ole�35�. From a programming perspective, OLE 2.0 offers the means to build applications that interoperate more effectively. It is an application programming interface (API) that defines a set of functions programmers can use to incorporate advanced object linking and embedding capabilities into their applications. With OLE 2.0 , developers can define a set of operations and make them accessible to other applications. These operations have argument lists, much like a function call in a programming language.

The most critical architectural capability of the OLE 2.0 object model standard is OLE automation. OLE automation provides an interface for applications to “expose” OLE objects as programmable software components. These objects can be bitmaps, charts, tables and application features, such as Charting, in Microsoft Excel. 

Application support for OLE Automation can take two forms:  as an OLE automation controller, or as an object which supports OLE automation. Programming languages, macro languages, and other development tools which support OLE 2.0 as a controller will be able to control OLE objects. For example, from within Microsoft Excel 5.0 a developer can write a program to open a copy of Microsoft Word 6.0 and perform a series of commands in Microsoft Word. In this example, Microsoft Excel is the OLE automation controller and Microsoft Word is the OLE automation object. 

Microsoft Excel supports the ODBC standard which allows access to a wide variety of data sources and enables direct programmability to databases. Microsoft products will include ODBC Desktop Database Drivers. This common database interface will simplify development and use of custom solutions. 

Using Microsoft Excel, developers will have increased power because of OLE automation and ODBC drivers. This power translates into new custom applications providing seamless interoperability to the user.

Lotus 1�2�3

Lotus 1�2�3 does not support OLE 2.0. Lotus has a proprietary technology that is called TOOLS, which is a layer over OLE 1.0. TOOLS makes it easier for Lotus to provide links.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel supports OLE 2.0 automation in two ways. First, you can control other OLE objects from within Microsoft Excel. Second, features of Microsoft Excel are objects that can be called from an OLE controller, like Microsoft Visual Basic 3.0. This provides great power and flexibility to developers.

	Lotus 1�2�3 does not support OLE 2.0. Lotus' TOOLS technology is not open and objects created from TOOLS cannot be shared.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel 5.0 will include ODBC Desktop Database Drivers. Lotus 1�2�3 does not offer these drivers in the product. In fact, Lotus 1�2�3 uses DataLens drivers which is proprietary technology.

Charting and Presentation

Charting and presentation help to relay the message of your data. Both the analysis and formatting features will improve the quality of your charts. Additionally, these features should be intuitive and easy to learn. 

Creating Charts

Microsoft Excel

You can create a chart by selecting a range of data to chart and clicking the ChartWizard button on the toolbar. The ChartWizard guides you through the steps required to create a chart. You can quickly display Help information as you're working by choosing the Help button. The ChartWizard has a Sample Chart box that reflects formatting settings for your chart as you make them. The Sample Chart uses your data so you see an actual preview of your chart as you are creating it. 

You can create the chart on the worksheet with you data. In addition, Microsoft Excel offers a special chart sheet that you can add to your workbook. This chart sheet simplifies printing a chart because it represents a full page.

For more direct charting, you can select a range of data and choose one of the 14 different charts by clicking the Chart Type button on the chart toolbar. You can also select the Default Chart button and Microsoft Excel will automatically create a bar chart for you. Both of these methods allow you to create a chart in one step.

When selecting data for the chart, you can use multiple selection to select nonadjacent data series all at once. This allows you to chart different segments of your information without having to reconstruct the table.

Lotus 1�2�3

When you create a chart, Lotus 1�2�3 uses the initial default chart type, a bar chart. Select the range or collection of data you would like to chart and press the Chart button on the toolbar. You can change the default by clicking on the chart and selecting Chart Type from the charting menu. You can also change the orientation of the chart in the Chart Type box. Lotus 1�2�3 allows you to include the title in the range of data you are selecting and it also will include a table of your data below the chart if you choose this option. 

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	In addition to the one-step chart options, the ChartWizard in Microsoft Excel will step you through designing your chart so it will be exactly as you wish. Lotus 1�2�3 offers only a one-step chart button that creates a chart in the default format. If you need to change the chart type or alter the orientation, you must go back and do that after the chart is created. You must also edit and reposition titles and legends when the chart is complete. The ChartWizard allows you more control than Lotus 1�2�3 because you decide the format initially and can preview your chart as you build it.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 does allow you to include titles in your range selection and it will recognize these as chart titles. Microsoft Excel does not recognize titles, but allows you to create titles while ChartWizard is building your chart.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 allows you to incorporate a table of data into your chart. Microsoft Excel does not support this capability.

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose Open. In the Directories box, double-click the Excel folder. Double-click the Examples folder.

�SYMBOL 183 \f "Symbol" \s 10 \h�	In the File Name list select SALES.XLS and choose the OK button. Select cells B4 to D8. Click the ChartWizard button on the top row of the toolbar, towards the right. The cursor turns into a chart representation; click and drag from cell B10 to G24. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	The ChartWizard will step you through creating the chart. Choose the Next button at Step 1. At Step 2, choose the Next button to choose the 2-dimensional column type. At Step 3, select Format 1 and choose the Next button. Choose Next at Step 4. At Step 5, click in the Chart Title box and type: Regional Sales

	Choose the Finish button.

Utilizing Charting Analysis Features

Microsoft Excel

Microsoft Excel offers many analysis features for charting. In response to a large number of suggestions to our Microsoft Excel Wish Line, Microsoft Excel 5.0 incorporates Trendlines and Curve Fitting into the charting capabilities. For a selected series, Microsoft Excel will overlay the trendline on the chart when you choose Trendline from the Insert menu.

Microsoft Excel 5.0 also includes Error Bars which indicate a certain amount of uncertainty when plotting points. Microsoft Excel supports two types of error bars, uncalculated and calculated. Uncalculated error bars are based on data that the user supplies on their worksheet for positive and negative error values of a point. Calculated error bars are calculated based on the value of the point and the other points on the chart. The error bar option is available by clicking on a series and choosing Selected Series from the Format menu. 

Using Graphical Goal Seek, you can directly manipulate charts with your mouse in order to perform quick “what-if”analyses on the data in the worksheet. For instance, if your data is represented in a column chart you can use your mouse to select one of the columns, making it shorter or longer. This change will be reflected in your actual data. This capability is available for Bar, Column, and Line charts by selecting the data series and then pressing ctrl while holding the mouse button and dragging.

Lotus 1�2�3

Lotus 1�2�3 does not offer any graphical analysis tools such as those mentioned above.

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	We will add a trendline to the chart you created in the first section. Double-click in the chart to open it. Clickce on one of the columns;  this represents a data series. From the Insert menu, choose Trendline. Select a type of trendline, any type is fine. Choose the OK button.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Now we will look at graphical goal seek. Click two times slowly on the column representing North sales in January;  handles will appear around the column. Hold the cursor over the top of the column so the cursor turns into an up-and-down arrow. Click and hold the mouse button and increase or decrease the column size. When you release the mouse button, the table of numbers will automatically update with the new value.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Click outside of the chart to see your data.  Notice the value in North sales for January has changed from its original value of 10111.

Editing Charts

Microsoft Excel

Easier charting and more formatting flexibility are among the most-common Microsoft Excel Wish Line requests. To address this, Microsoft Excel 5.0 developed Hands On Charting which lets you directly select and manipulate individual chart elements such as legends, titles, labels, etc. This major advancement in charting makes each part of the chart (title, legend, plot area, etc.) movable, sizable, and modifiable. You will now be able to click a legend and resize it with your mouse. The legend will resize and automatically adjust the other graph items. You can also click the title or the axis labels and edit the text directly on the chart.

Additionally, charting has been made truly WYSIWYG. What appears on your sheet will look the same as the printed chart.

Updating a chart is now easier in Microsoft Excel 5.0. From our product support calls we found that most people were recreating entire charts when they had to add new data points. Now you can simply select the new information in your table and drag it onto the chart. With Drag and Plot, Microsoft Excel 5.0 will update the chart to include the new data points.

In earlier versions of Microsoft Excel, graphs and charts were edited in a separate window. In Microsoft Excel 5.0, chart customization and editing is done entirely on the sheet. 

Lotus 1�2�3

Lotus 1�2�3 allows you to click objects such as titles, legends, and axis titles in the chart to move and resize them. To edit these entries, double-click the object;  a dialog box will come up to edit text. Lotus 1�2�3 charts are WYSIWYG so they print as you see them on the worksheet. 

Charts in Lotus 1�2�3 can be updated with new data series by selecting Ranges from the Chart menu, choosing the appropriate Assign Ranges category (rows or columns) and selecting the new data series. 

When resizing charts, Lotus 1�2�3 will stagger and adjust labels and titles so they fit in the new chart space. 

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	If you add data to your table and want to update your chart in Lotus 1�2�3, you must go into a dialog box, select the correct assigned range and select the new data. This can be cumbersome and tricky. Microsoft Excel  makes this process much simpler and more intuitive by providing a visual method to update your chart, drag and plot.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Although Lotus 1�2�3 offers on-chart moving and resizing of titles, labels, etc., you cannot edit the text on the chart. Editing text must be done in a dialog box that appears when you double-click the object. Microsoft Excel allows you to edit on the chart, which is more intuitive.

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	Let's edit the chart we have created. Double-click the chart to make it active. Clickce on the title, Regional Sales. Move the cursor to the edge of the box so the white arrow appears. Hold the mouse button down and move the title to the left, release the mouse button.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Hold the cursor over Regional;  you should see an edit bar. Click one time; now you can edit text.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Click outside the chart to see your data. In cell E4 type: March

	In cell E5 type: 8200

	In cell E6 type: 25350

	In cell E7 type: 11290

	In cell E8 type: 16750

�SYMBOL 183 \f "Symbol" \s 10 \h�	Select cell E4 to E8. Move the cursor to the bottom edge of the range until a white arrow appears. Press the mouse button and drag the mouse down over your chart. Release the mouse button and the chart will update with the new data.

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose Close. When asked if you would like to save, choose the No button.

Formatting Charts

Microsoft Excel

Microsoft Excel offers many capabilities to format a chart for presentation. Regarding the chart itself, Microsoft Excel now supports Curve Smoothing for line and scatter charts. By selecting the smoothing option, the chart will change the jagged point-to-point lines to smooth curved lines. Microsoft Excel offers other chart enhancements such as drop lines, high-low lines and up-down bars. In response to customer requests, Microsoft Excel includes Doughnut Charts as a chart option. Finally, you can create Combination Charts by clicking on a series in your graph and choosing Chart Type from the Format menu. This allows you to easily combine line, bar, and area charts.

Customers also want to control the formatting of the titles and axis labels. In chart text, you are able to use the Rich Text capabilities and mix font attributes and sizes, including superscript and subscript. Users also want to format the axis by being able to change the numbers. Charting now offers the standard number formatting options found in Microsoft Excel for percentages, currency, dates, scientific, etc. 

Microsoft Excel lets you re-size the legend and set formatting options (i.e. for spacing between entries). Legends can be sized, and moved anywhere on the chart. Additionally, customers can change the orientation of the legend elements. For example, if your legend was built for the side of the graph with one label below another, you could drag the legend box to flatten it out so the labels were next to one another.

Once you have created a chart and formatted it the way you would like, you can save these settings to apply to future charts. By choosing AutoFormat from the Format menu you can easily save your chart settings in the gallery. When you want to create a chart with the same look, you will be able to select it from the gallery.

Lotus 1�2�3

Lotus 1�2�3 offers many chart types including bar charts, line and area charts, pie charts and radar charts. Mixed charts are also available in Lotus 1�2�3. To create a mixed chart, choose Ranges from the Chart menu, select the series you would like to change and choose a mixed type of line, area or bar. Each series can be edited in this manner. You can also select preset mixed formats from the Chart Type menu option. 

Lotus 1�2�3 offers formatting for the axis numbers when you select the axis and choose Number Format from the Style menu. Standard currency, percentage, scientific, etc. formats are available; you can alter the number of decimal places.

Lotus 1�2�3 allows you to change the default chart type by selecting a chart and choosing Set Preferred from the Chart menu. After doing that, Lotus 1�2�3 will use this chart type and grid settings as the new default when the Chart button on the toolbar is clicked. If you have created a chart and would like to apply the default settings, choose Use Preferred from the Chart menu.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 and Microsoft Excel offer many of the same graph types. However, Microsoft Excel offers many more enhancements such as chart smoothing, drop lines, high-low lines and up-down bars.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Formatting elements of the chart is much simpler in Microsoft Excel because of the tab dialog boxes. When you select an element all the formatting options are available in one place, unlike Lotus 1�2�3. For example, by double-clicking an axis in Microsoft Excel you will see the following tab dialog box giving you options for Scale, Font, Number format, Alignment, etc. 

�



	Microsoft Excel Format Axis tab dialog box

	Double-clicking the y-axis in Lotus 1�2�3 gives the following dialog box and options box. To change the number format or the font, you must choose Number Format from the Style menu and Font & Attributes from the Style menu.
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	Lotus 1�2�3 Y-Axis format and options dialog boxes



�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 allows you to set number formats but offers fewer options than Microsoft Excel. For example, in the currency format for Lotus 1�2�3 the only changes you can make are to the number of decimal places. Microsoft Excel, on the other hand, allows you to change the color of positive and negative numbers separately, decimal points, symbols, commas, etc.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 does allow you to change the default graph type and grid settings based on your chart style; but you cannot change formatting for text or numbers. In addition, Lotus 1�2�3 does not let you create custom galleries based on your chart settings, as Microsoft Excel does. The galleries in Microsoft Excel will save you much time in formatting if you use specific chart styles for your work.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel allows you to have Rich Text formatting in your chart text. This means, for example, that you can put superscripts in your title, and underline only certain words in the axis titles. Lotus 1�2�3 will support only one type of font and attribute setting for the entire title or legend.

Microsoft Excel Sample

�

Above is an example of the Rich Text, number format, and curve smoothing features available in Microsoft Excel 5.0.

Creating and Importing Graphics

Microsoft Excel

Use the tools on the Drawing toolbar to draw arrows, ellipses, rectangles, arcs and text boxes directly on your worksheet or chart. Double-click any of these objects to change the attributes of the object. For instance, you can select double arrow heads for your arrow type or rounded corners for your rectangle. These drawings reside in a graphic layer on top of your worksheet or chart so they do not interfere with your data. They can be dragged and sized using your  mouse. 

The Insert Picture command accepts .BMP, .PCX, and standard graphic formats. A Preview Picture option on the Picture dialog box lets you view the item before it is inserted. You can also copy and paste directly from some Windows programs such as Paintbrush. Imported graphic objects such as pictures and clip art are handled in the same manner as drawings. They can be overlapped, brought to the front or back, grouped, or sized and moved directly, without interfering with the data. 

With the new graphics capability in Microsoft Excel, you can easily create picture graphs. Simply click the series you would like represented with pictures, and choose Picture from the Insert menu. You have the option to stack or stretch the picture to fill the column representing your data. 

These graphic objects, whether drawings or imported pictures, can be attached to cells so that they change sizes if you resize your worksheet or graph. By attaching to cells, you can also sort graphic objects and they will move with the row or column of data. 

Lotus 1�2�3

You can create lines, arrows, shapes and text blocks in Lotus 1�2�3. Some of the basic figures are on the toolbar (i.e. square, arrow). To select other tools, such as a rounded rectangle, choose Draw from the Tools menu for a list of all available shapes. When you double-click any drawn object, the Lines & Color dialog box will appear. This lets you change the line style and colors of objects. For squares, this dialog lets you choose special designer borders such as frames. You can draw lines, shapes, and text boxes on a worksheet or on a graph. Lotus 1�2�3 offers the capability to rotate an object any number of degrees.



To bring in a picture, you can copy a picture from another program to the Clipboard and paste it into a Lotus 1�2�3 worksheet. You can also choose Insert Object from the Edit menu and select from a list of many programs including Paintbrush. When you choose from this list you will be taken directly into the selected application.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	You can apply only one font, attribute, and color to the entire contents of a text box in Lotus 1�2�3. Microsoft Excel enables you to have Rich Text in text boxes. With Microsoft Excel you can bold one word, change the color of another, change the font of another word and add super- and sub-scripts–all in one text box.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Once you have drawn a graphic object in Microsoft Excel, you can double-click it to see the Format Object dialog box. This gives you options to change the color, line style, or pattern of the object. You can also assign your graphic objects to cells so they may be moved and sized with those cells. Lastly, you can protect your object by locking it. When double-clicking a Lotus 1�2�3 graphic object, you have color, line style, and pattern options. Other settings must be made elsewhere in the menu.

�SYMBOL 183 \f "Symbol" \s 10 \h�	When you assign a graphic to a cell in Microsoft Excel, you can sort a graphic object with the worksheet. You can also sort by graphics, using a custom list. You cannot do this in Lotus 1�2�3.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel enables you to create picture graphs. Lotus 1�2�3, on the other hand, does not support this capability.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 offers designer frames for square shapes. Microsoft Excel does not have any special frames for squares.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel does not allow you to rotate an object as Lotus 1�2�3 does.

�SYMBOL 183 \f "Symbol" \s 10 \h�	The Insert Picture feature in Microsoft Excel allows you to preview pictures and then insert the files directly. Lotus 1�2�3 requires you to copy to the Clipboard before you are able to import a picture.

Microsoft Excel Sample
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Above is a picture chart created in Microsoft Excel 5.0.

Applying Text Attributes

Microsoft Excel

Because of a large number of requests from the Microsoft Excel Wish Line, Microsoft Excel 5.0 added single and double accounting underlines, conforming to the accounting standards. You can apply these to all the numbers or text in one box or just selected portions of the cell contents.

To help in your presenting and formatting, Microsoft Excel makes it easy to adjust text in cells. First, Microsoft Excel offers various orientations for text in a cell. You can make text in cells vertical by simply selecting the cell(s) and choosing Cells from the Format menu. This will bring up a dialog box allowing you to change many settings for the cell. Microsoft Excel has always supported text wrapping for horizontal text; but now you are able to wrap vertical text as well.

Once you have formatted a cell with the appropriate underlines, colors, and fonts you can easily apply these settings to other cells. Simply use the Format Painter button to apply the formats of one cell or object to other cells or objects. Select the cells from which you would like to copy the formats, click the Format Painter button on the toolbar, and select the destination cells. The formatting will be applied to your selection.

Microsoft Excel also offers an intelligent AutoFormat feature. When you select AutoFormat, you can choose from many predefined formats. Microsoft Excel will intelligently determine the table range you want to format based on the cell location, identify labels, numbers, and formulas, and correctly apply subtotal and grand total styles.

Lotus 1�2�3

Lotus 1�2�3 provides the ability to single underline and double underline by selecting Style Font & Attributes. Underlines will be applied to the entire contents of the cell.

Lotus 1�2�3 has the ability to display horizontal and vertical text. You are also able to rotate the text any number of degrees you would like. This is accessible through the Style Alignment dialog box.

As in Microsoft Excel, you can apply formats from a selection of cells to another selection of cells in Lotus 1�2�3. The procedure is similar–select the cells from which you would like to copy the formats, click the Copy Style button on the third level toolbar, and then click the destination cells.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 offers double underlining but not accounting double underlining which complies to the accounting standards. Microsoft Excel provides both single and double accounting underlining as well as normal underlining capabilities.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 has the capability to display text in a variety of manners, even at varying degrees. However, 1-2-3 can wrap text only horizontally whereas Microsoft Excel can wrap text both vertically and horizontally.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Both programs offer a means to copy styles or formats; however, this button is more easily accessible in Microsoft Excel because it is on the standard toolbar.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Both Lotus 1�2�3 and Microsoft Excel have many options for formatting cells. The advantage in using Microsoft Excel is that all of these options are organized in one tab dialog box so you can apply all of your formatting in one place and not return to the menu multiple times.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel offers intelligent AutoFormat, that will “sense” how your information should appear. Lotus 1�2�3 does not offer this intelligent aspect to automatic formatting.

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose New to get a new workbook. Type any numbers in cell A1, A2 and A3. Click cell A1 using the right mouse button. Choose Format Cells from the bottom of the menu. Once in the Format Cells box, select the Number tab. In the Category list, select Accounting. Select the last code listed in the Format Codes box. Select the Font tab. Click the arrow in the Underline box, choose Double Accounting found at the bottom of the list. In Font Style, select Bold. Choose the OK button.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Cell A1 is now nicely formatted. To apply this to the others, select cell A1. Click the Format Painter button found in the top row of the toolbar. Move the mouse to cell A2. Hold the mouse button and select cell A2 and A3. Release the mouse button and the formatting is applied.

�SYMBOL 183 \f "Symbol" \s 10 \h�	If the columns are now too narrow, move the mouse to the line between A and B in the column headings. When the cursor is a solid cross with arrows at the sides, double-click. The column will automatically adjust to best fit.

�SYMBOL 183 \f "Symbol" \s 10.5 \h�	Retain this sheet for the next set of exercises.

Printing

Microsoft Excel

Microsoft Excel 5.0 has simplified determining print settings by organizing many of the options in a new Page Setup tab dialog box. After you have set your options, you can preview your document to be sure it will print as you are expecting. Print Preview, introduced in Microsoft Excel version 3.0, shows your entire document without you having to define a range. You can move back and forth between pages, zoom in for a closer look, and change page setup by clicking a button. Print Preview is interactive, so you can adjust column widths and margins simply by dragging “handles”that appear in the window. 

To further enhance the headers and footers in Microsoft Excel, the Header/Footer tab in the Page Setup box offers you 18 different choices for header and footer content. You can also create custom headers and footers. In response to a request we heard from many customers, we have given you control of the header and footer positioning so you can change the distance of headers and footers from the edges of the page. 

Lotus 1�2�3

Lotus 1�2�3 has a print preview option which lets you change the setup, move through pages, and zoom. Through the Page Setup dialog box you can enter text in the headers and footers. Lotus 1�2�3 provides icons for including the date, page number, etc. in the headers and footers. You can also type special symbols to include this information.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	You cannot directly manipulate your document while in Print Preview in Lotus 1�2�3. In Microsoft Excel, you can drag the margins for the headers, footers and sheet. You can also directly select where to zoom in. Lotus 1�2�3 does not support direct interaction with Print Preview.

�SYMBOL 183 \f "Symbol" \s 10 \h�	The Header and Footer option in Lotus 1�2�3 does not allow you to change the font or character attributes. In addition, you can't specify top and bottom margins for the header and footer. This is all possible using Microsoft Excel.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel offers 18 standard header and footer options to choose from. Lotus 1�2�3 does not offer any predefined headers and footers.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel offers a Page Setup tab dialog box which incorporates many more settings than the Page Setup in Lotus 1�2�3. In addition, the Page Setup in Microsoft Excel allows you to go right to the Print Preview. In Lotus 1�2�3 you must return to the File menu option to choose Print Preview.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 allows you to save your print settings. Microsoft Excel does not support this.

Microsoft Excel Sample Exercises

�SYMBOL 183 \f "Symbol" \s 10 \h�	Still using the accounting formatted worksheet, from the File menu, choose Print Preview. When the preview appears, choose the Margins button.

�SYMBOL 183 \f "Symbol" \s 10 \h�	By placing the cursor over the black handles on the page, you can directly adjust the margins. When the cursor turns into a solid cross, simply press the mouse button and drag. You can adjust the margins for the worksheet and for the headers and footers.

�SYMBOL 183 \f "Symbol" \s 10 \h�	To zoom in on your data, hold the cursor, which looks like a magnifying glass, over the data and click the mouse button. To go back to the full page, choose the Zoom button. Choose the Close button when you have finished previewing.

�SYMBOL 183 \f "Symbol" \s 10 \h�	From the File menu, choose Close. Choose the No button when asked if you would like to save.



Workgroup

To increase the efficiency and productivity of your office, everyone needs to be working together. Tools are available to help you achieve this by facilitating file sharing and managing input and comments from many users.

Sharing Work with Your Group

Microsoft Excel

Like Microsoft Word, Microsoft Excel now has a Find File command. Find File provides a means for browsing and managing large quantities of documents, especially when sharing documents with a group on a network server.

Microsoft Excel allows multiple users to have read-only access to a file; but only one user can have read-write access to a file. To help manage file sharing, Microsoft Excel developed a notification capability. If a you are waiting for a file that is currently in use, you can open the read-only version and Microsoft Excel will notify you when the read-write version becomes available. Microsoft Excel also provides a refresh capability that will let you update a read-only version to reflect the changes in the read-write version.

Overall, sharing is facilitated by the Workgroup toolbar which places the new workgroup features in one convenient place. The toolbar allows users to toggle read-only and read-write status, send mail, add routing slips, and find and update files.

Microsoft Excel supports the Universal Naming Convention (UNC) which will make it easier to access network files. This feature enables you to specify a server by name only, eliminating the need to specify a drive. Because of UNC, files are more portable and can be saved for external or remote references. That will allow network connections to work properly, regardless of the drive mappings on an individual's machine.

Microsoft Excel 5.0 for the Macintosh will also support Apple's Open Collaboration Environment (AOCE). This technology is similar to MAPI for the Windows environment.

Lotus 1-2-3

You can share files using Lotus Notes or using a network. To share files using Lotus Notes you create a shared file which is a sealed Lotus 1-2-3 file saved on a Notes server. Using Notes, workgroup members can simultaneously work with files without writing over each other's work. 

To share files using a network, you create a file on a network file server that all members of your workgroup can access. Only one user, the user who has the file reservation, can save changes to the file on a network. Other users can open the file at the same time, but cannot save the file as long as someone else has the reservation.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel offers a Find File feature to help you locate files on a network and on your computer. Lotus 1-2-3 does not have this capability. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1-2-3 does not provide notification to the user when a shared file becomes available for updating. Microsoft Excel provides this capability.

�SYMBOL 183 \f "Symbol" \s 10 \h�	To achieve the full value of sharing files in Lotus 1-2-3, you must purchase and use Lotus Notes. The sharing capabilities of Microsoft Excel have been fully integrated into the product and no additional software is needed.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel has developed a toolbar that specifically addresses your Workgroup needs. Lotus 1-2-3 does not group its workgroup features on a convenient toolbar.

Mailing and Routing Worksheets to Others

Microsoft Excel

On the Microsoft Excel Workgroup toolbar you will find a Send Mail button. This lets you launch mail right from Microsoft Excel, and automatically attaches your current workbook. 

In addition to mailing a document from within Microsoft Excel, the user can now add a routing slip to a document. The user can route a document to a set of addresses in parallel or one after another, optionally tracking status or requesting that the document is returned after routing is complete. Routing slips are a convenient way to circulate a worksheet or copies of a worksheet to allow other users to enter scenarios. The user can also merge scenarios from other worksheets.

Microsoft Excel for Windows supports the Messaging API (MAPI) and Vendor Independent Messaging (VIM) standards. In addition, AOCE is supported in Microsoft Excel for the Macintosh.

Lotus 1-2-3

You can use the File Send Mail command to send a range, chart, drawn object, or an entire file as an electronic mail message. To do this, you need Lotus Notes release 2.1 for Windows or later, or Lotus cc:Mail release 1.11 for Windows or later.

You can also use File Send Mail with other mail applications that use the Vendor-Independent Messaging Interface (VIM), and with Microsoft Mail running under Windows for Workgroups version 3.1.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1-2-3 does not offer routing capability like Microsoft Excel. With the File Send Mail command in Lotus 1-2-3 your mail will be distributed to everyone on the list at the same time;  you are not able to circulate the file to one person after another.

Collaborating with Your Group

Microsoft Excel

The Scenario Manager is an ideal way to get input from many people on various uncertainties in business. The workgroup capabilities in Microsoft Excel allow your team to route a document with various scenarios, create new scenarios on a protected Workbook, hide confidential scenarios, and merge scenarios. Scenario Manager will track the history so you know who created each scenario, when it was created, and any comments regarding the numbers or projections. 

To analyze the various scenarios, Scenario Manager now allows the user to report scenarios to a Pivot Table. A Pivot Table is the best way to analyze the results of combining various scenarios. Pivot Tables allow customers to mix different scenarios to see the impact on selected results. The report will also make it easy to browse through the scenarios by different attributes, such as creator.

The Auditing toolbar provides easy access to the visual auditing tools available in Microsoft Excel. The auditing feature draws arrows illustrating the relationships between worksheet cells or across worksheets in a workbook. The user can double-click the head or tail of a tracer arrow to navigate between related cells. Visual auditing tools are a convenient way for the user to understand worksheets shared with other users.

Lotus 1-2-3

Version Manager has been designed to work on an individual basis or with a group. When multiple people are providing input, Lotus 1-2-3 will save each version and critical user information such as who provided the information, when it was updated, and the reason for the new version. Versions from different users can be merged for easier management.

Lotus 1-2-3 provides auditing tools under Tools Audit. You can find all the formulas in your worksheets, formula precedents and dependents, circular references, file links, and DDE links. Tools Audit reports the results of an audit either by selecting all cells of the specified type or by displaying a list of these cells.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Because Microsoft Excel provides a routing feature, the collection of different scenarios using Scenario Manager is prioritized and organized by the order in which you need to receive the information. Lotus 1-2-3 does not support this.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Version Manager will track the entire history of the document including formatting, formulas and constants. Scenario Manager tracks only constants.

�SYMBOL 183 \f "Symbol" \s 10 \h�	The most crucial aspect of collecting different versions of information is analyzing it correctly. Microsoft Excel offers you the tools to do this through Pivot Tables. Lotus 1-2-3's Version Manager helps in collecting the information; however, it does not offer a solid analysis tool. Currently, Lotus  1-2-3 provides a rather cumbersome report writer to analyze results.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel offers Pivot Tables designed to easily combine scenarios and view the result. This is a very visual and dynamic method, as opposed to combining version to create scenarios in Lotus 1-2-3.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1-2-3 provides the results of audit checks by selecting cells on the worksheet or presenting a list. Microsoft Excel, however, has made this a very visual process by providing arrows to cue you to formula dependencies and circular references. This is much easier to follow and understand.

Microsoft Excel Sample
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The auditing cues above show the precedents for Total Sales Revenue.

Organization Issues

To ensure your organization is up and running quickly, your spreadsheet choice must minimize the training requirements, simplify the installation process, and address various compatibility issues.

Training

Microsoft Excel

Microsoft Excel has updated the Help system to include step-by-step procedures for tasks. Additionally, we've implemented a Help on Top design which keeps the open Help window on top of the worksheet while you are completing the task. 

Computer-based training is now integrated into the help system. Examples and demos appear at different locations in Help to provide more information about the features. When you request an example and demo, the system guides you through the use of that feature. There are over 100 lessons integrated in Help.

Microsoft Access pioneered a new technology in Cue Cards. These are procedures placed on cards which remain on top of the application. Similar to the Help on top in Microsoft Excel, Cue Cards provide the step-by-step procedures to perform tasks. Cue Cards make it possible to learn while you do your work.

The quick preview in Microsoft Excel gives users an online tutorial of the latest enhancements to Microsoft Excel. This lesson makes getting up and running with the new features quick and easy.

To improve the documentation, Microsoft Excel 5.0 includes more examples and graphics showing how Microsoft Excel addresses real customer needs in customer settings.

Lotus 1�2�3

The User's Guide provides basic concepts and step-by-step procedures for the most common Lotus 1�2�3 tasks, and directs you to Help for information not in the User's Guide. Lotus 1�2�3 provides an online help that documents every feature, menu command, and dialog box. Help is the primary source for detailed information about @functions and macros. Lotus 1�2�3 also offers an online Guided Tour which gives you a quick overview of the work area and introduces new features. The online Tutorial provides interactive lessons that teach you how to use the major features of Lotus 1�2�3. 

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel has integrated demos and tutorials into Help to give you visual instructions on using a feature. Lotus 1�2�3 does not provide this.

Setup

Microsoft Excel

Microsoft Excel 5.0 includes a new Setup tool which will be common to all Microsoft Applications. Setup is now intelligent enough to know if other Microsoft products are installed and will automatically pick up registration information.

Also with this new tool comes the ability to build your own customized setup. Users can create a specific list of files to be included. This flexibility lets users create custom network setups. With the custom setup, standard corporate templates or default settings can become automatic during setup.

Also, in support of the network environment, the Microsoft Excel tutorial operates on read-only network share. This allows multiple people to run the tutorial off of the network; but none of them can write to it so the tutorial files are protected.

The install tool also remembers information about what is currently installed for an individual application. This enables users to uninstall options or install additional options. This flexibility means that users no longer need to know the location of all  the files and can use this one method to manage their application setups.

Lotus 1�2�3

The Installation disks allow you to setup Lotus 1�2�3 for the first time or to return to Install later to add optional features or Help files you didn't install the first time. The Install program displays a series of dialog boxes that prompt you for information. Install displays information about the options in the dialog box you're currently using. 

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	No special provisions are made for uninstall or network setup in Lotus 1�2�3. Microsoft Excel created features to address these specific needs. 

�SYMBOL 183 \f "Symbol" \s 10 \h�	Lotus 1�2�3 does not offer a tutorial to operate on a read-only network share.

Supporting Multiple Platforms

Microsoft Excel

Microsoft Excel developers invested four years in creating shared “core” code for the Windows graphical environment and the Macintosh platform, so you can share spreadsheets, charts, and macros across platforms. No file or macro conversions are necessary. Additionally, users see the same commands, features, and tools on both platforms, which lowers the training and support costs for cross-platform users.

Although the user interface is almost identical to the Windows-based product, Microsoft Excel for the Macintosh has implemented certain system level optimizations based on the differences in environments. An example of this is our rich support of AppleScript™, Apple Events, QuickTime™, Publish and Subscribe, Data Access Language (DAL), and more.

Lotus 1�2�3

Lotus 1�2�3 offers a spreadsheet for the Macintosh; however, it has a completely different look and feel. Currently, Lotus 1�2�3 does not employ a core code design for the Macintosh and Windows environments.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel has focused on making the transition between platforms seamless with a core code development process. Lotus 1�2�3 has not reached a high level of consistency between their Windows and Macintosh spreadsheet products.

Supporting Multiple Formats

Microsoft Excel

Microsoft Excel reads and writes files created with all earlier versions of Microsoft Excel, Lotus 1�2�3 release 2.x and 3.x files, Lotus 1�2�3 release 1.1 for Windows, Quattro Pro 4.0 for DOS, Allways files, Impress files, dBASE II, dBASE III+, and dBASE IV, SYLK, text, CSV, and DIF.

Lotus 1�2�3

Lotus 1�2�3 can open or save the following file types:  earlier Lotus releases, Symphony Releases, Microsoft Excel, and products that create ASCII text files. 

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel supports a much broader range of file formats than Lotus 1�2�3.

Transitioning from Lotus 1-2-3

Microsoft Excel

Over 2 million people have switched from Lotus 1�2�3 to Microsoft Excel, and more are moving each day. For Lotus 1�2�3 users, we have created a special online lesson that gets them acquainted with Microsoft Excel quickly and easily. Microsoft Excel also has special Help for Lotus 1�2�3 users available from the Help menu.

Microsoft Excel provides a unique support tool for Lotus-trained users to make the transition to a Windows-based spreadsheet easier. Help for Lotus 1�2�3 Users is accessible though the Microsoft Excel Help menu or through the familiar slash (/) key. By entering a Lotus 1�2�3 keystroke sequence, users can receive help on performing the equivalent command in Microsoft Excel either through a demonstration or posted step-by-step instructions. This means that a user can maintain productivity while learning the graphical interface.

Microsoft Excel also provides extensive help for new users who are familiar with conventions used in Lotus 1�2�3. For instance, choosing the Transition Formula Entry helps users learn Microsoft Excel function syntax by entering functions using Lotus 1�2�3 syntax.

The  Macro Interpreter in Microsoft Excel reads and runs Lotus 1�2�3 macros compatible with Lotus 1�2�3 release 2.01.

Lotus 1�2�3

Lotus 1�2�3 will bring up a classic menu when the user strikes the slash (/) key. You can then perform the functions as you would in Lotus 1�2�3 for DOS.

Differences

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Excel provides materials to help Lotus 1�2�3 for DOS users learn Windows conventions and commands. Lotus 1�2�3 release 4.0 allows you to carry out the DOS steps but does not help you to learn Windows.

System Requirements

Comparing spreadsheets also involves understanding the system resources they require.

Microsoft Excel

�SYMBOL 183 \f "Symbol" \s 10 \h�	MS�DOS operating system version 3.1 or later.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Any one of the following: Microsoft Windows version 3.1 or later, Microsoft Windows for Workgroups version 3.1 or later, Microsoft Windows NT version 3.1 or later, Microsoft Windows for Pen Computing.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Personal computer using a 286 or higher microprocessor.

�SYMBOL 183 \f "Symbol" \s 10 \h�	4 MB of memory.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Requires a minimum of 8.5 MB of hard disk space.

�SYMBOL 183 \f "Symbol" \s 10 \h�	A 3.5-inch or 5.25-inch disk drive.

�SYMBOL 183 \f "Symbol" \s 10 \h�	EGA or higher resolution monitor compatible with Microsoft Windows 3.1 or later.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Mouse or compatible pointing device (mouse recommended).

Lotus 1�2�3

�SYMBOL 183 \f "Symbol" \s 10 \h�	MS�DOS operating system version 3.3 or later.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Microsoft Windows version 3.0, 3.1 or later in standard and enhanced mode. Includes Microsoft Windows for Workgroups version 3.1 or later, Microsoft Windows NT version 3.1 or later.

�SYMBOL 183 \f "Symbol" \s 10 \h�	IBM PC or compatible (286 and higher) including PS/2 and Compaq models.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Requires a minimum of 4 MB of RAM. Use on a 286 computer in some configurations may require additional memory.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Requires a minimum of 8 MB of hard disk space.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Windows compatible printers and EGA, VGA, Super VGA, XGA and 8514/A color displays.

�SYMBOL 183 \f "Symbol" \s 10 \h�	Mouse recommended but not required.

�Evaluation of Support Services

Another important aspect of your spreadsheet decision is the support services available–provided by the company and external sources. 

Microsoft Excel

Telephone Assistance:  Dedicated phone lines allow users to access individual product support for Microsoft products, Monday through Friday, 6 a.m. to 6 p.m. PST, excluding holidays. Approximately 160 employees are dedicated to Microsoft Excel support. TDD/Text Telephone services are also available for the deaf and hard of hearing.

Microsoft FastTips:  FastTips provides quick access to answers of commonly asked questions, delivered by automated voice response or by fax. Accessed by any touch-tone phone, this interactive automated system also includes a library of technical notes that are available by fax or mail. It is available 7 days a week, 24 hours a day.

CompuServe�SYMBOL 226 \f "Symbol"� Forums:  Microsoft has many User Forums on CompuServe for Microsoft products, allowing customers to electronically engage in a technical dialog with Microsoft support engineers. Microsoft also sponsors the Microsoft Developer Services Area on CompuServe, focusing on forums dedicated to developer issues, that provide information through interactive dialog among peer developers and Microsoft developer support engineers.

Microsoft Knowledge Base:  The Microsoft Knowledge Base is a database of more than 40,000 articles about software support and the latest information about Microsoft products. This database is used by Microsoft's technical support engineers and is also available on CD-ROM to customers, provided through TechNet and MSDL (discussed below).

Electronic Service Requests:  Electronic Service Requests (ESR's) packages give customers who prefer additional electronic support the opportunity for private responses from a Microsoft support engineer.

Microsoft Download Service (MSDL):  MSDL offers users electronic access to application notes, printer drivers, sample applications, and commonly accessed Microsoft Knowledge Base articles, via modems and terminal emulation software. This download service can be accessed 7 days a week, 24 hours a day.

Microsoft Developer Network:  The primary information resource for applications developers using Microsoft products, the Microsoft Developers Network is an annual subscription with four quarterly updates of network CDs containing detailed information for Windows- and Windows NT-based development.

TechNet:  TechNet is an annual subscription of 12-monthly CD's containing technical information for systems integrators and solution providers using Microsoft products. Monthly updates include Microsoft Knowledge Base articles, resource kits, training materials, conference notes, application notes and strategic information. The TechNet subscription also allows users access to the Microsoft TechNet forum on CompuServe.

Microsoft Press�SYMBOL 226 \f "Symbol"�:  Microsoft publishes books on both technical and non-technical topics. These include additional training and usage materials.

Independent Solution Providers (ISV's):  Because Microsoft products are so prevalent and have such powerful development tools, an entire network of independent solution providers has developed. You can easily find developers with expert knowledge of Microsoft Excel and Microsoft Visual Basic, which is now the common macro language among Microsoft products. 	Microsoft's Consultant Relations Program can refer you to independent consultants in your area of the United States.

Training:  Microsoft Authorized Training Centers offer several services for Microsoft product users. These include: customized training for end users and trainers, training material development, and consulting services. In addition, there are many third-party training materials, such as books and videos.

Lotus 1�2�3

Lotus FAX Support:  You can access technical bulletins, product specifications, and instructions to order upgrades for Lotus products and releases through Lotus FAX Support. 

Interactive Voice Support:  Interactive Voice Support provides answers to the most frequently asked questions about products such as Lotus 1�2�3 release 4.0.

Remote Automated Support:  This service offers you access to the latest technical support bulletins, product updates, worksheet template, and other Lotus product information and enhancements. With this service, you can use a computer and a modem to access a library of technical information.

Customer Support:  Each new Lotus product or upgrade includes a 90-day complimentary period of toll-free support. 

PROMPT Support Membership for Individual Users:  Annual Memberships to Lotus PROMPT Support can be purchased for the Lotus Desktop products. Prior to the expiration of your initial period of complimentary support, you will be notified of your expiration date and provided with an opportunity to extend your support through an annual PROMPT Support membership. 

CompuServe:  You can use the Lotus Forums on CompuServe to get answers to your technical questions, exchange ideas with thousands of other users, or get the latest product information and updates. You can communicate online with Lotus Technical Support and other users on the forum's electronic message board.

CD/PROMPT:  The CD/PROMPT disk provides access to over 30,000 technical documents. 

Corporate Support Programs:  These are designed exclusively for corporations with help desks or information centers that deliver front-line technical support to end users.

Training:  Lotus Authorized Training Companies are located throughout North America and offer classes on your Lotus software. Lotus books, videos and courseware are also available.



�Evaluation Summary�

Both Microsoft Excel and Lotus 1�2�3 for Windows have a large number of features, as discussed in the evaluation. The two products are comparable in some of the more basic areas, and both let you manipulate and display data in many different ways.

However, we believe this evaluation adequately demonstrates that Microsoft Excel is a more mature and advanced product than Lotus 1�2�3. Now in its fifth generation, Microsoft Excel benefits from years of development in the Windows environment, during which user input and extensive usability research have guided the direction of its evolution. A few of the key differences between Microsoft Excel and Lotus 1�2�3 are summarized below:

�SYMBOL 110 \f "Wingdings" \s 6 \h�	Microsoft Excel 5.0 goes beyond ease-of-use by bringing IntelliSense�SYMBOL 228 \f "Symbol"� Technology to users. Tools like the TipWizard and Drag and Plot demonstrate IntelliSense Technology in Microsoft Excel. These features actually “sense” what the user wants to do and intelligently produces the desired result. This level of user awareness is not found in any other spreadsheet today. 

�SYMBOL 110 \f "Wingdings" \s 6 \h�	Microsoft Excel 5.0 delivers innovative data management and analysis tools. In Microsoft Excel 5.0 we introduce a set of features that take the routine and complexity out of managing lists of information. The AutoFilter, Sorting, Subtotals, and Outlining features significantly reduce the time and effort users have to expend on converting their information into meaning, reports and summaries.

	Microsoft Excel provides users flexibility and a dynamic method to analyze and report their multi-dimensional data with the PivotTable Wizard and Pivot Tables.  

�SYMBOL 110 \f "Wingdings" \s 6 \h�	Microsoft Excel 5.0 is part of the strongest family of applications. The Microsoft Office family of programs reflects an emphasis on consistency and integration. To reduce training time among applications, Microsoft products have developed a consistent interface through the use of similar Toolbar buttons, Dialog boxes, Tab Dialog boxes, ToolTips, Cue Cards and Wizards. The family offers advancements in integration through OfficeLinks and OLE 2.0 technologies.

�SYMBOL 110 \f "Wingdings" \s 6 \h�	Microsoft Excel 5.0 offers the best support for customization and programmability. We have delivered tools which make it easy for all levels of users to customize Microsoft Excel to meet their business needs. At a more basic level, users can easily customize worksheets using On Sheet Controls. 

	For the more advanced developers, Microsoft Excel offers Visual Basic, Applications Edition as the macro language. This will be the common macro language in Microsoft products. Visual Basic offers more powerful features than traditional macro languages. Visual Basic will significantly reduce the time and cost of developing custom solutions through faster development, reusable code, and a large community of Visual Basic developers.

�SYMBOL 110 \f "Wingdings" \s 6 \h�	Microsoft Excel 5.0 offers the broadest support for end-user collaboration. Microsoft Excel provides support across the broad scale of workgroup activities–from ad hoc file sharing to collaboration on “what-if” analysis. Our Routing, Find File, and Auditing toolbar support users in the most common group activity–sharing files and work. Additionally, Scenario Manager provides a means of collaboration and managing input from various users. The benefit of Scenario Manager over other “what-if” analysis tools is that users can build a PivotTable of their scenario results. This reporting and analysis mechanism is critical to achieve the benefits of getting input from multiple sources.

	Basic spreadsheet capabilities are becoming more similar as the technology develops. To really evaluate a spreadsheet, you must take the time to look beyond the surface of the worksheet and see what tools are offered to help automate your work and improve your analysis. These tools should not be simply available, but discoverable and accessible to the user. Microsoft Excel 5.0 addresses these issues by offering you innovative features that are designed with the customer in mind.

�Appendix A–Feature Tables

Basic Usage

Usability impacts all levels of users, from beginner to developer. To improve your group's productivity, basic tasks should be intuitive and automated where possible.

Interface Optimization�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows���Move/size objects directly on worksheets�Yes�Yes���Right-click context-sensitive menus�Yes�Yes���Tab dialog boxes�Yes�No���Help in all dialog boxes�Yes�Yes���Samples in dialog boxes�Yes�Yes���User-sensitive productivity suggestions�TipWizard�No���Wizard Technology ���Yes�No���Hide and unhide documents �Yes�Yes���One-click automation�Toolbars�SmartIcons™���Color palettes available on the toolbar�Yes�No���Toolbars consistent in appearance, functionality �Yes�No���Toolbar button identification�ToolTips�Title bar text���Color toolbars�Yes�No���Customize toolbars�Yes�Yes���Task-oriented toolbars�Yes�Yes���Move toolbars by direct manipulation�Yes�No���Move buttons on toolbars by direct manipulation�No�Yes���Modifiable toolbars (shape) �Yes�Yes����Number of simultaneous toolbars �Limited only by memory�1���Live Status Bar�No�Yes����

Creating and Editing Worksheets�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows���Move and copy cells using the mouse�Yes�Yes���Move and insert cells with mouse�Yes�No���Direct manipulation of row/column size�Yes�Yes���Automatically fit column to longest entry�Yes�Yes���One click to select entire row/column/worksheet�Yes�Yes���Align numbers other than to the left�Yes�Yes���Wrap text in cells�Yes�Yes���Multiple fonts, colors, and attributes in a cell�Yes�No���Direct cell editing�Yes�Yes���Automatic detection of data range�Yes�Single cells only���AutoSum columns and rows in one click�Yes�Yes���AutoSum recognizes subtotals�Yes�No���Automatic Subtotals�Yes�Partial (Aggregation in Query Objects)���One-click sorting capability�Yes�No���Custom sort orders�Yes�No���Filter data using list box on worksheet�Yes�No���Capability to collapse/expand detail�Outlining�No���Create custom fill lists in application�Yes�No����Fill/extend series automatically�Yes�Yes���Selection of nonadjacent cells and ranges�Yes�Yes���Partial insertion�Yes�Yes���Enter data into multiple cells of selected range�Yes�No���Undo/Redo�Yes�Undo only���Repeat last action command�Yes�No���Direct access to named ranges�Name Box�Navigator���Named constants and formulas�Yes�No����

Managing Files and Worksheets�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows���Organize groups of worksheets�Workbooks�Files���Number of worksheets allowed�Limited only by memory�256 sheet limit���Organize different types of sheets in groups�Yes�No���Worksheet tabs�Yes�Yes���Drag-and-drop across workbooks�Yes�No���Hide individual sheets�Yes�No���Print orientation for individual sheets�Yes�No���Different sheet types�Yes�No���Optional setting for default sheets�Yes�No���Discontiguous sheet selection�Yes�No���Use sheet names of more than eight characters�Yes�Yes���3-dimensional formulas�Yes�Yes���Close all open files at once�Yes�Yes���Multiple views of same workbook /file�Yes�No���Goto history (remembers last 4 locations)�Yes�No���Sound Notes �Yes�No���List of most recently used files �Yes�Yes���Delete files from within application�Yes�Yes���Automatic file saving�Yes�Yes���File protection and encryption�Yes�Yes���Shortcut keys (accelerator keys)�Yes�Yes���

Data Access and Analysis

Organizations are flooded with information on a daily basis.  Your spreadsheet must help you manage and make sense of this data.  You need powerful tools that facilitate the process of gathering and analyzing facts.

Data Access�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows���Access to remote databases�Microsoft Query�Tools Database menu (DataLens API) ���ODBC Support�Yes�Through DataLens���Seamless import of ASCII files�Text Import Wizard�No����

Data Analysis�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows���Multi dimensional data analysis�Pivot Tables�No����SYMBOL 183 \f "Symbol" \s 8 \h�	Assistance to create multi dimensional reports�PivotTable Wizard�No����SYMBOL 183 \f "Symbol" \s 8 \h�	Direct manipulation of data labels�Yes�No����SYMBOL 183 \f "Symbol" \s 8 \h�	Integrated in worksheets�Yes�No����SYMBOL 183 \f "Symbol" \s 8 \h�	Refresh tables�Yes�No����SYMBOL 183 \f "Symbol" \s 8 \h�	Automatic calculations such as percentages, totals�Yes�No����SYMBOL 183 \f "Symbol" \s 8 \h�	Access to internal or external data or combine multiple worksheets�Yes�No����SYMBOL 183 \f "Symbol" \s 8 \h�	Automatic date grouping�Yes�No����SYMBOL 183 \f "Symbol" \s 8 \h�	Audit Drill down�Yes�No����SYMBOL 183 \f "Symbol" \s 8 \h�	Pivot Charts�Yes�No���Crosstab reports�Yes�Yes���Solve single-variable problems�Goal Seek�BackSolver���Graphical goal seek�Yes�No���Solve multi-variable problems�Yes�Yes���Solve with multiple answers�Yes�Yes���Save/recall multiple what-if scenarios in one sheet�Scenario Manager�Version Manager���Data form�Yes�No���Data consolidation of unique worksheets�Yes�No���

Assistance in completing functions�Function Wizard�No���Most recently used functions�Listed by Microsoft Excel�User-defined���Number of worksheet functions�300+�200+���Paste function arguments directly in cells�Yes�Yes���Custom functions�Yes�No���Arrays�Yes�No���Show precedents/dependents�Yes�Yes���Cell notes attached separately�Yes�No����Working with Multiple Applications

Customers increasingly need to use multiple software programs, such as a spreadsheet, word-processing, and presentation package.  Because of this trend, software companies must ensure applications are consistent and integrated to reduce training needs and improve their ability to work together.

Consistency and Integration features�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows���Consistent Menu Bars between spreadsheet, word processing, and presentation programs�8 of 9, same order�7 of 11, different order���Common Dialog Boxes between spreadsheet, word processing, and presentation programs�Yes�No���Consistent Toolbars between spreadsheet, word processing, and presentation programs�Yes�Yes���OLE 1.0 client and server support�Yes�Yes���OLE 2.0 client and server support�Yes�No���OLE 2.0 cross-application Drag-and-drop�Yes�No���OLE 2.0 in-place editing of objects�Yes�No���Insert spreadsheet in word processor�Yes�Yes���Integrated setup/shared functions�Yes�No���Switch/launch several programs�Microsoft Office Manager�Yes���

�Customization and Programmability

Creating solutions specific to your needs will enhance your productivity. Your spreadsheet should offer tools to perform a range of activities, from basic worksheet customization to system development.

Customization Features�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows���Customizable Toolbars�Yes�Yes���Customizable menus�Yes�Yes���Edit toolbar buttons�Yes�Yes���Macro buttons�Yes�Yes���Controls on sheets (list boxes, scroll bars)�Yes�No���Dialog Box Editor�Yes�Yes����Menu Editor�Yes�No���Common macro language among product family�Visual Basic�No���Function (command-based) macro language�Yes�Yes���Macro Recorder for mouse and keystrokes�Yes�Yes��Macros stored in separate sheets�Yes�No���Macro functions�440�250���Built-in macro debugger�Yes�Step mode only���Assign macros to any object�Yes�No��Templates�Yes�No���OLE 2.0 Automation�Yes�No���C Language API�Yes�No���Object Browser�Yes�No���Call external DLLs�Yes�No���Programmatic access to ODBC�Yes�Limited���International macro sheets�Yes�No��Software development kit available�Yes�Yes��

�Charting and Presentation

Charting and presentation tools help relay the message of your data. When considering charting capabilities, analysis is equally as important as formatting.  As a rule, presentation capabilities are strong in Windows products.  Additionally, these features should be intuitive and easy to learn.

Charting features�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows���One-step charting�Yes�Yes���Assistance to build charts�Chart Wizard�No���Charts can be stored on their own sheet�Yes�No���Chart editing on worksheet�Yes�Yes���Direct manipulation of chart elements�Yes�Yes���One step chart updating with new data�Drag and Plot�No���Vary fonts and attributes in titles and legends�Yes�No���Automatic detection of chart titles�No�Yes���Automatic legend�Yes�Yes���Automatic formatting of charts�Yes�No���User-defined chart gallery�Yes�No���Drawing on charts�Yes�Yes���Automatic trend lines�Yes�No���Curve smoothing�Yes�No���Drawing objects resize with graph�Yes�No���Error bars�Yes�No���Create picture charts using clip art�Yes�No���Multi-level chart labels�Automatic�No���Goal Seek on chart�Yes�No���Double-click for chart formatting dialog boxes�Yes�Yes���Direct 3-D chart rotation with the mouse�Yes�No���Scalable fonts in charts�Yes�Yes��Link legend, title, and text labels to worksheet�Yes�Yes���Charting toolbar�Yes�Yes����

Presentation�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows���Text wrap within cells�Vertical and horizontal�Horizontal���Spelling checker�Yes�Yes���Text rotation�Vertical and horizontal�Full���Center text across columns�Yes�Yes���Custom number formats�Yes�No���Accounting underlines�Yes�No���Automatic formatting of worksheets�Intelligent �Yes���Format multiple worksheets simultaneously�Yes�Yes���Apply format to multiple cells�Format Painter�Copy Style���Hide an entire row or column�Yes�Columns only���Drawing toolbar�Yes�Limited drawing tools available on default set���Draw directly on the worksheet�Yes�Yes���Sort graphic objects�Yes�No���Designer frames�No�Yes���Flip, turn, and skew graphs and objects�No�Yes���Preview available when inserting a picture�Yes�No���Colors available�56�256���Patterns�18�64���Borders�8�7���Color borders�Yes�Yes���Drop Shadows�Yes�Yes����			

Printing�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows���Automatic fit option for printing�Yes�Yes���Default print area�Yes�Yes���Automatic print of whole document�Yes�Yes��Print multiple ranges�Yes�Yes��Fit to page�Yes�Yes��Directly manipulate margins/column width in Print Preview�Yes�No���Directly select zoom area in Print Preview�Yes�No���Print from Print Preview�Yes�Yes���Move between pages in Print Preview�Yes–with scroll bar�Yes–keystroke only��Page setup from Print Preview�Yes�Yes��Specify distance of headers and footers from edge of page�Yes�No���Multiple fonts and attributes in headers and footers�Yes�No���Predefined headers/footers available�18�No���Save print settings�No�Yes���Named print settings�Yes�Yes��Landscape and portrait orientation�Yes�Yes��Print charts apart from the worksheet�Yes�Yes���

Workgroup

To increase the efficiency and productivity of your office, everyone needs to be working together.  Tools are available to help you achieve this by facilitating file sharing and managing input and comments from many users.

Feature�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows��What-If Analysis�Scenario Manager�Version Manager���SYMBOL 183 \f "Symbol" \s 10 \h�	Multiple sets of changing cells�Yes�Yes���SYMBOL 183 \f "Symbol" \s 10 \h�	Merge scenarios�Yes�Yes���SYMBOL 183 \f "Symbol" \s 10 \h�	Hierarchical scenarios�No�Yes���SYMBOL 183 \f "Symbol" \s 10 \h�	Lock scenarios�Yes�No���SYMBOL 183 \f "Symbol" \s 10 \h�	Dynamic reports�Yes–using Pivot Tables�No���SYMBOL 183 \f "Symbol" \s 10 \h�	Version Annotation�Yes�Yes���SYMBOL 183 \f "Symbol" \s 10 \h�	Simultaneous file editing �No�Requires Notes���

Feature (continued)�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows��Find file �Yes�No��Interactive file sharing�Yes�Yes��File notification�Yes�No��Send mail�Yes�Yes��Routing�Yes�No��Visual auditing cues�Yes –arrows depicting dependencies�Yes– highlights impacted ranges��Workgroup toolbar�Yes�No��MAPI support�Yes�No��VIM support�Yes�Yes��Support Universal Naming Convention�Yes�No��Support AOCE to exchange mail with a Macintosh�Yes�No��File Import/Export into Notes database�Yes�Yes��Notes Mail Support�Yes�Yes��

Organization Issues

To ensure your organization is up and running quickly, your spreadsheet choice must minimize the training requirements, simplify the installation process and address various compatibility issues.

Training and Staff Needs�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows��Help screen remains visible during operation�Yes�Yes��Step-by-step procedures visible on application�Cue Cards�No��Computer-based training integrated into Help�Yes�No��Online tutorial of product enhancements�Yes�Yes��Online, context-sensitive help�Yes�Yes��Help buttons in all dialog boxes�Yes �Yes��Online tutorial�Yes �Yes��Online example files�Yes�Yes��Interactive teaching tool for Lotus-trained users�Yes�No��AutoSave�Yes�Yes��Load recoverable data in case of error�Yes�No��Provide system, version, and product information�Checkup�No��Training and Staff Needs�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows��Provide information about hardware and software configuration.�Microsoft Info�No��Training and Staff Needs (continued)�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows��Provide information about hardware and software configuration�Microsoft Info�No��		

Installation�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows��Custom Install�Yes�Yes��Laptop Install�Yes�Yes��Network Install�Yes�Yes��Uninstall�Yes�No��		

Multiple Platforms and Formats�Microsoft Excel 5.0�Lotus 1�2�3 rel. 4.0 for Windows��Products share file formats across platforms�Yes�No��Same commands and features across platforms�Yes�No��Core code with Macintosh versions�Yes�No��1�2�3 releases 2.x and 3.x, including Allways and

     Impress files�Yes�Yes��Excel files�Yes�Limited Excel 3 �and 4��dBASE files�Yes�No��Reads Quattro Pro MS DOS files�Yes�No��Lotus 1�2�3 release 2.x macros�Yes �Yes��Lotus 1�2�3  release 3.x macros�No�Partial��Lotus 1�2�3 for Windows release 1.1 �No�Partial through Translator��Help for Lotus 1�2�3 MS DOS users�Yes�Classic Menu��Reads Symphony files�No�Yes��

�System Requirements

Following is a comparison of the system requirements.

Requirement�Microsoft Excel 5.0�Lotus 1�2�3 ver. 4.0 for Windows��MS DOS Operating System�ver 3.1 or later�version 3.30 or later��Microsoft Windows�ver 3.1 or later�ver 3.0 or later��RAM�4 MB�4 MB��Microprocessor�286 or higher�286 or higher��Input device�Mouse or compatible pointing device�Mouse��Minimum disk space�8.5 MB�8 MB��

Product Support

The following table details the types of support Microsoft Excel and Lotus 1�2�3 ver. 4.0 for Windows users can expect.

Type of Product Support �Microsoft Excel 5.0�Lotus 1�2�3 ver. 4.0 for Windows���Dial-up technical support, recorded�Yes�Yes��Dial-up technical support, live�Yes�Only for 90 days without subscription��Information via FAX�Yes�Yes��Information via online services �CompuServe�CompuServe��Information downloadable via modem�Yes�Yes��Information via CD-ROM�Yes�Yes��Customized training at training centers�Yes�Yes��

�You must have installed the Data Access files during setup to retrieve these files. Please see page �pageref data_access_install�1� for specific directions.

�Developer implications of OLE 2.0 capabilities are addressed on page �pageref programming_ole�42�.

� Wizards are tools that are included with many Microsoft products. They quickly and interactively step a user through the various choices and options necessary to achieve a certain goal.  For example, Microsoft Excel provides the ChartWizard and the FunctionWizard.

�To change the shape of a set of SmartIcons in Lotus 1-2-3 rel. 4.0, you must first define the set as floating.

�To create a custom fill list in Lotus 1-2-3 ver. 4.0, you must modify the FILLS.INI file using the notepad and restart the application.

�The Dialog Box Editor in Lotus 1-2-3 is external to the actual application.
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�PAGE \# "'Page: '#'�'"�Page: 76���we should footnote what wizards are.  [DONE-BDS]






